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Portrait One Manager is the Answer 
 

Thank you for purchasing Portrait One Manager.  You’ll find it’s a user-friendly, powerful 
tool designed to increase efficiency and profitability for today’s studios.    
 
Running a photography studio demands creativity, artistry and the flair for the dramatic. 
 
Running a SUCCESSFUL photography studio requires sophisticated business skills and 
management savvy. 
 
Portrait One Manager supplies the management tools; you supply the creativity.   
 
Portrait One Manager is the answer to the difficult issues that you face during day-to-day 
studio management.  Portrait One Manager is the way to resolve inefficiencies in 
scheduling and production for you and your employees.  Portrait One Manager is the key 
to providing extraordinary customer service and to increasing cash flow by upgrading the 
invoicing process.  Portrait One Manager helps you to know your customer and shows 
you how to enhance profitability based on your customer’s potential photography needs.  
You’ll soon discover that Portrait One Manager is the answer to maximizing your time 
and getting the most out of your studio and your employees.    
 
Even though Portrait One Manager is very user-friendly and easy to use, you’ll need to 
ease into the operation of new software.  A separate manual, the “Portrait One Manager 
Getting Started Guide,” is available to help you become familiar with the basics and 
allows you to immediately begin receiving the benefits of the program.  This User Guide 
is designed to give you the in depth information that you may need to master your new 
software.  As with most software, you’ll find several ways of accomplishing certain tasks.  
To avoid confusion, we’ll keep it simple.  Use the way that works best for you.   

 



 Page 10 

Words to the Wise 
 
Throughout this manual, you’ll see boxes that contain the following graphics: 
 

 Here’s a Flash for You! 
 
“Here’s a Flash for You!” provides helpful hints, definitions and tips.   
 

 

 Bugged About Something?? 
 
“Bugged About Something?” voices questions that may be in your mind.   
 

 

 

    ATTENTION!   
 
“Attention” boxes contain an important fact or warning.   
 

 

 Pathways to Success  
 
“Pathways to Success” boxes offer tips on how to reach the full potential 
of Portrait One Manager to expand your business and build your 
reputation as a studio that exceeds customer expectations, along with 
maximizing both studio and employee efficiency. 
 

  
 

Let’s get started!
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Choosing Single User or Multi-User Installation 
 

If you’re installing an evaluation copy of Portrait One Manager, you have the option of 
installing it in a single user or multi-user environment.  If you’re installing a licensed 
(purchased) copy of Portrait One Manager, your type of installation is limited to the type 
of license you’ve purchased.  

   

Installation 
 

Okay, let’s get started!  Before you can use Portrait One Manager, the installation 
program must copy some files onto each workstation you plan to use Portrait One 
Manager.  To do this, follow these instructions: 

 
Step 1: Read all installation instructions 

 
Please read this entire chapter FIRST!   Having a basic understanding of the 
Portrait One Manager Installation Program before beginning installation can save 
time. 
 

Step 2: Check Portrait One Manager System Requirements 
 
 Make sure that the system on which you’re installing this program meets all of 

the minimum system requirements to properly run your Portrait One Manager 
program: 

 

 Windows 98 Windows 2000/NT/XP/ME 
Processor Pentium II Pentium III 
Minimum RAM 64 Meg 128 Meg 
Recommended RAM 128 256 
Hard Disk Space for 
Program Files 

50 Meg 50 Meg 

Hard Disk Space for  
Data Files 

2 – 20 Meg 2 – 20 Meg 

Monitor Resolution 800 X 600 or Better 800 X 600 or Better 
 
Step 3: Remove existing Portrait One Manager installation from 

your hard disk (if any) 
 
If you have a previous version of Portrait One Manager on your hard drive, follow 
the steps below to remove it: 
 
1. From the Start button choose Settings, Control Panel. 
 
2. Open Add/Remove Programs. 
 
3. Highlight Portrait One Manager and click on the Add/Remove button. 

 
4. If you’re asked whether you want to remove shared components, answer 

“yes”.   
 

5. If you get a message that says a certain file was not found, continue anyway. 
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Step 4: Install Portrait One Manager to your hard disk 
 

First, we recommend that you close all applications prior to beginning the 
installation process.     
 
1. Insert the Portrait One Manager installation CD into your CD-ROM drive.  

The installation program will launch. 
 
2. If the installation program does not launch, double-click on the “My 

Computer” icon on your computer’s desktop.  Double-click on the CD drive 
icon.  Double-click on SETUP.EXE. 

 
3. During installation, follow the online prompts of the Setup Wizard.  It’s our 

recommendation—unless you’re an experienced computer user—that you 
accept the defaults provided.   

 

 Bugged About Something?? 
 
What type of installation should I choose? 
If you will be using Portrait One Manager on just one PC, you should choose the 
‘Single User Installation’.  If you want to share Portrait One Manager over a 
network of PC’s, you’ll need to select the ‘Multi-User’ option, but which one?  
Select the ‘New Multi-User’ option for the first PC on which you’re installing 
Portrait One Manager, and then select ‘Existing Multi-User’ for each additional 
PC. 
 

 
4. When prompted for the Company Name, type in your studio name.   

 

 

    ATTENTION!   
 
The Company Name CANNOT be changed, so make sure you spell and 
punctuate your studio name correctly, as this is how it will appear on your 
invoices, etc. 
 

 
5. You’ll next be prompted to provide the user’s full name and initials, along with 

a password.  We recommend that you leave the password blank at this time.  
Don’t worry--it can be filled in later if required for security purposes.   

 

 

    ATTENTION!   
 
Make a note of the name and initials that you’ve just filled in—you’ll need the 
information each time you log into the Portrait One Manager program.  
Passwords are case sensitive; the User ID information is not. 
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6. The final screen asks whether you want to launch the Internet Update Utility.  
This utility will automatically search our website for the latest version of 
Portrait One Manager to install.  If you have an Internet connection on this 
computer, you can launch the Update Utility (see next section for more 
information on updates.)  Otherwise, just click Finish to complete your 
installation.   

 

Optimizing Portrait One Manager 
 

Now that you’ve completed the installation process, it’s time to optimize your installation 
to ensure optimal performance and stability of the software.  If you need help following 
these steps, please call your technical support specialist.   
 

1. Install Latest Portrait One Manager Service Release.  You have two options 
to install this update.  The first is to launch the Portrait One Manager Internet 
Upgrade Utility and click the Begin Update button.  This program will use your 
Internet connection to find the latest update for Portrait One Manager, 
download it, and install it.  The second option is to manually connect to 
www.phaseone.com, click the Downloads button, and then click the latest 
service release update to download.  When you download this update, save it 
to a subfolder called SPUpdates inside your Portrait One Manager data folder.  
The next time you run Portrait One Manager on each workstation, the update 
will be installed.   

 

 Here’s a Flash for You! 
 
Portrait One Manager Software is committed to continually improving its 
software.  We encourage you to regularly put “Revisit www.phaseone.com” on 
your To-Do list to ensure you have the latest update of Portrait One Manager 
installed.   
 

 
2. Install Latest Microsoft Jet Service Release.  Because Portrait One 

Manager depends on certain Microsoft files, it is important to make sure that 
you have the most current Jet Service Release installed on each workstation.  
Microsoft has released a separate update for each operating system.  You 
need to determine which update you should download for each of your 
workstations.  Click on the following update(s) to download to your computer.  
Once downloaded, simply double-click to install. 

 
Windows 
98/NT 

ftp:// ftp.phaseone.dk/portrait/Win/Portrait%20One%20Manager/Util/Jet40SP6_9xNT.exe  

Windows 
2000 

ftp:// ftp.phaseone.dk/portrait/Win/Portrait%20One%20Manager/Util/Jet40SP6_W2K.exe  

Windows 
XP 

ftp:// ftp.phaseone.dk/portrait/Win/Portrait%20One%20Manager/Util/Jet40SP6_WXP.exe  

Windows 
ME 

ftp:// ftp.phaseone.dk/portrait/Win/Portrait%20One%20Manager/Util//Jet40SP6_WMe.exe  

 
3. Optimize Your Server.  If you are running a Windows 2000 or NT Server to 

store your data files, it is critical that you disable Op Locks to ensure the 
integrity of your data files.  Don’t worry, you don’t need to know what an Op 
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Lock is.  We’ll make it simple for you.  Simply click on the following link to 
download a small file to your server.  Once downloaded, double-click on it to 
install. 

 
Windows 
NT 

ftp:// ftp.phaseone.dk/portrait/Win/Portrait%20One%20Manager/Util//DisableOpLocksNT.reg  

Windows 
2000 

ftp:// ftp.phaseone.dk/portrait/Win/Portrait%20One%20Manager/Util/DisableOpLocks2K.reg  
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    ATTENTION!   
 
If you are running a Windows 2000 or NT Server to store your data files, it is 
critical that you disable Op Locks to ensure the integrity of your data files.   
 
 
Congratulations!  Pat yourself on the back.  You’ve completed the 
installation and setup.  You are now ready to run Portrait One 
Manager.   
 

  

 Bugged About Something?? 
 

But what do I do next?  
 
We’re getting to that—don’t rush us.  Okay, you’ve completed installation and 
setup.  Now you’re ready to launch Portrait One Manager and log in.  When 
launching, you have the option of either viewing Portrait One Manager with 
sample data already entered in or starting to key in information about your own 
studio. 
 
 

 
 

Launching Portrait One Manager and Logging In 
 
1. From the Start Menu, choose Programs, click the Portrait One Manager group and 

then choose ‘Portrait One Manager with Sample Data’ to view sample data files or 
choose ‘Start Portrait One Manager’ to start entering your own data. 

 
2. Type in your user I.D. (See, we told you you’d need that information again!) and your 

password, if applicable.   
 

3. Press ENTER or click the OK button. 
 
 

Welcome to Portrait One Manager! 
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Navigating the Browse Screens 
 

Portrait One Manager features browse screens for the Calendar, Clients, Sessions, 
Invoices, Phone Calls, Production and Images.  Each view has a corresponding function 
key (see view menu), but you may also change views by clicking the down arrow next to 
the browse screen name, shown in bold at the upper left.  Click the arrow and drag down 
to the desired view.  Then release your mouse button.   
 

 

 Here’s a Flash for You! 
 
Browse screens provide a quick list of your data, and also allow you to quickly 
view records shown on the screen.  Double clicking on any entry in the browse 
screen will bring up the associated record. 
 
 

 
The Calendar Browse Screen 
 

When you start Portrait One Manager, the program opens up to the Calendar Browse 
screen shown below.   
 

 

 
The Calendar Browse Screen - Studio Plus always opens up to this screen. 
 

���������	
��
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As you see, the calendar defaults to the current user and today’s date.  The Mini 
calendars on the upper right can assist you in selecting the days you wish to view.  You 
can also choose your viewing by Users and Inside Locations.  See the section “Working 
with Calendar” for more detailed information. 

 
 

The Other Browse Screens 
 

The records displayed on other browse screens can be sorted by any of the fields shown.  
Just click on the column heading and the records will sort by that column.  Click again 
and the records are sorted in reverse order. 
 
You may also select which records display on a browse screen, or search for a record on 
a browse screen.  All browse screens except the calendar have a search box in the upper 
right corner.  Click the down arrow next to the search window box and drag down to the 
type of criteria you want to use to display or search.  Then, type the specific criteria in the 
search box and press Enter, or select the criteria from the drop down menu and press 
Enter. 
 
Take a look at the example below: 
 

 
 

 
 

 
 
 
 

 
 
 

Use the Browse 
Menu to switch 
between Browse 
Screens. 

Sort columns by 
clicking on the 
header.  Click 
again for 
descending order. 

Click here to 
change the search 
criteria option. 

Enter your search 
criteria here, then 
press Enter. 
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Features of the Calendar Browse Screen 
 

The Calendar Browse Screen is the best way to view the schedules for all users and 
locations. A location can be any facility, studio, room, or area for which you want to track 
a schedule.  The schedules for multiple users and locations can be viewed 
simultaneously in an easy-to-read graphical layout, making it easy to compare schedules 
or look for availability. Double clicking on any available time slot launches the easy to use 
schedule wizard, which will automatically create a session or appointment for a new or 
existing client along with the invoice and receipt of payment, if necessary.  Double 
clicking on any existing session or appointment will launch the appropriate information 
screen with further details.   

 
 

 
The Calendar Browse Screen 
 
Get familiar with the Calendar Browse screen shown above, which is the default screen 
for Portrait One Manager.  You can click on the Calendar icon at the top of the page for a 
drop down menu, which we call the Browse Menu.  The Browse Menu is used to switch 
between Browse Screens.  As you see, the calendar defaults to the current user and 
today’s date.  The Mini calendars on the upper right side assist you in selecting the days 
you wish to view.  You can also choose your viewing by Users and Inside Locations. 
 

���������	
��
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 Pathways to Success  
 
Ta Da!  Introducing (drum roll) To-Do! 
To-Do, an exciting feature of Portrait One Manager that takes the burden of 
remembering stuff off your shoulders!  Keep track of phone calls to return and 
supplies to order.  Remember your wedding anniversary and the time of your 
son’s baseball game on Thursday.  Consolidate all those scribbled reminders on 
scraps of paper and Post-it notes onto the To-Do feature of the Portrait One 
Manager Calendar.  To-Do tracks all those tasks, phone calls and essentials that 
are key to the success of any business and to day-to-day living.  Discover the 
satisfaction of checking off your accomplishments and knowing you’ve got a 
handle on all those nagging, important details.   
 

 
More To-Do!  This feature is so easy to use–click on the appropriate space to enter a 
new To-Do or double-click to record more detailed information regarding the to-do. Tasks 
continue to roll forward on the calendar until you click the box indicating that the task has 
been completed.  Overdue tasks appear in red.  A personal To-Do can only be viewed by 
the person to whom the To-Do is assigned. 
 

 
 

 Here’s a Flash for You! 
 
Here are some handy tips to help you modify your schedule: 
♦  To enter special Date Headers, such as “Christmas” or “Bunny Promotion”,   
   click the date header at the top of the calendar.  Enter description, special open  
   hours, etc. 
♦ Resize appointment or session blocks to change the start or end time. 
♦ Drag-n-Drop appointment or session blocks to move appointment or session  
    to a new time/date. 
♦ Right-click an appointment, click Copy, then right-click on empty time slot(s) 
    and select Paste. (This is great for repeating appointments, such as Monday 
     Golf.) 
♦ To enter a quick unlinked appointment, simply click once on the desired time  
   slot and start entering. 
♦ To delete an appointment/session, double-click on it, then press Delete. 
♦ To view today’s date, press Ctrl-T (for “Today”). 
 

 
 



 Page 26 

Navigating the Calendar—Some Handy Tricks for 
Schedule Viewing! 

 
1. To view multiple users, hold the Control key and click on the desired users. 
 
2. To view a range of users, click on the first user, then hold the Shift key and 

click the last user in the desired range. 
 
3. To de-select any user, hold the Control key and click on that user. 
 
4. To view multiple locations, hold the Control key and click the desired 

locations. 
 
5. To view a range of locations, click on the first location, then hold the Shift key 

and click the last location in the desired range. 
 
6. To de-select any current location, hold the Control key and click that location. 
 
7. To view multiple dates, hold the Control key and click the desired dates. 
 
8. To view a range of dates, click on the first date, then hold the Shift key and 

click the last date in desired range. 
 
9. To view all of a specific day of the week for a given month, click on the first 

letter of the day (located at the top of each mini calendar) that you wish to 
view. 

 
Example: To view every Wednesday in February, click on the W in the month of 

February.  To view every Wednesday in all mini calendars displayed, hold 
the shift key and click on the W above the top mini calendar. 

 
10. To view other combinations and ranges of combinations, hold the Shift or 

Control key and click on desired dates, users, and/or locations. 
 
Example:  To view every Wednesday in February for David Doe, select David’s 

name and click on the first Wednesday, then hold the control key and click on 
the remaining Wednesdays.  This will display the schedules for all of David’s 
Wednesdays in that month.  Or, click the “W” above the mini calendar to 
highlight all of the Wednesdays in that month. 

 
11. To view the previous month or next month’s calendar, click on the 

appropriate arrow button above the top mini calendar. 
 
12. To quickly scroll through the months, click on the name of the month above 

the top mini calendar and hold the mouse button down.  Move your cursor up 
to scroll backwards and down to scroll forwards.  The farther away from the 
center month that you move the cursor, the faster you’ll scroll.  This action is 
especially useful in scrolling to previous or future years. 
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 Here’s a Flash for You! 
 
Here’s some very important terms—memorize the definitions, there’ll be a quiz 
later. 
Session:  Any time you will be actually TAKING photos of a client. 
Appointment: Anything else placed on the calendar, such as a wedding 
consultation, a staff meeting, etc. 
Linked Appointment:  Any type of appointment that involves a client, such as a 
wedding consultation. 
Unlinked Appointment:  Any appointment that DOESN’T involve a client, such 
as a staff meeting. 
 

 
 

Creating a New Linked Appointment for an Existing 
Client 
 

1. To find the time and date, refer to the topic “Navigating the Calendar.” 
 
2. When you have located the desired time and date, double-click on it.  A 

scheduling wizard will pop up to walk you through the scheduling steps.   
 

3. From the Schedule Wizard choose “Create an appointment for a specific client.”  
Click Next. 

 
4. The default option is already set to “Search for an existing client.”  Click Next. 
 
5. To find the desired client, choose the search criteria from the drop down box and 

tab to the criteria field.  Enter the corresponding information (I.e. search criteria; 
last name, criteria field; Johnson.)  Then press Enter. 

 
6. All of the clients that match the criteria that you have chosen will then be 

displayed. 
 
7. If the client is not visible, you can find it by using the scroll bar or you can choose 

another criteria to search by and type in the appropriate information.  When you 
find the correct client, click in the gray box to the left of the client to select it.  
Click Next. 

 
8. Type in the appointment description.  Press Tab. 
 
9. Choose an Appointment Type from the drop down list or type one in.  Press Tab. 

 
 

 Here’s a Flash for You! 
 
The Appointment type determines what will be displayed on the calendar to 
describe that appointment. 
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10. Choose an Appointment Location from the drop down list or type one in.  Press 

Tab. 
 
11. Choose an Appointment End Time from the drop down list or type it in.  Click 

Next. 
 
12. Enter necessary notes about the appointment.  Click Next. 
 
13. If you wish to view or modify the appointment, click the check box labeled “Open 

Appointment for Additional Modifications” and click Finish, or just click Finish if 
viewing and/or revisions are unnecessary. 

 
 

Creating a New Linked Appointment for a New Client 
 

 Here’s a Flash for You! 
 
A Linked Appointment is tied to a specific client because it involves that client.  
For appointments that don’t involve a specific client, choose an Unlinked 
Appointment. 
 

 
 

1. To find the time and date, refer to the topic “Navigating the Calendar”.  
  

2. Double-click in the desired time slot.  
 

3. A scheduling wizard will pop up to walk you through the scheduling steps. 
 

4. From Schedule Wizard choose “Create an Appointment for a New Client.” 
 

5. Enter the client information.  Continue to click Next until prompted for 
appointment information. 

 
6. Enter the Appointment Description.  Press Tab. 

 
7. Choose an Appointment Type from the drop down list or type one in.  Press Tab. 

 
 

 Here’s a Flash for You! 
 
The Appointment type determines what will be displayed on the calendar to 
describe that appointment. 
 

 
 

8. Choose an Appointment End Time from the drop down list or type one in.  Press 
Tab. 

 
9. Enter necessary notes about the Appointment.  Click Next. 
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10. If you want to view or modify the Appointment, click the check box labeled “Open 

Appointment for Additional Modifications” and click Finish or just click Finish if 
viewing and/or revisions are unnecessary. 

 
 

Creating a New Unlinked Appointment (No Client) 
 

1. To find the time and date, refer to the topic “Features of the Calendar “. 
 

2. Double-click in the desired time slot. 
 

3. A scheduling wizard will pop up to walk you through the scheduling steps. 
 

4. From Schedule Wizard, choose “Create an Unlinked (no client) Appointment.”  
Click Next. 

 
5. Type in the Appointment Description.  Press Tab. 

 
6. Choose an Appointment Type from the drop down list or type one in.  Press Tab. 

 

 Here’s a Flash for You! 
 
The Appointment type determines what will be displayed on the calendar to 
describe that appointment. 
 

 
 

7. Choose an Appointment End Time from the drop down list or type one in.  Press 
Tab. 

 
8. Enter necessary notes about the appointment.  Click Next. 

 
9. If you want to view or modify the appointment, click the check box labeled, “Open 

Appointment for Additional Modifications” and click Finish, or just click Finish if 
viewing and/or revisions are unnecessary. 

 

Creating a Session for an Existing Client 
 
1. To find the time and date, refer to the topic “Features of the Calendar.” 
 
2. When you have located the desired time and date, double-click on it.  A 

scheduling wizard will pop up to walk you through the scheduling steps.   
 
3. The default option is already set to “Create a session for a specific client.”  Click 

Next. 
 
4. The default option is already set to “Search for an existing client.”  Click Next. 
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5. To find the desired client, choose the search criteria from the drop down box and 
tab to the criteria field.  Enter the corresponding information.  (I.e. search criteria; 
last name, criteria field; Johnson.)  Press Enter. 

 
6. All of the clients that match the criteria that you have chosen will then be 

displayed. 
 
7. If the client is not visible, you can find it by using the scroll bar or you can choose 

another criteria to search by and type in the appropriate information.  When you 
find the correct client, click in the gray box to the left of the client to select that 
client.  Click Next. 

 
8. Continue to click Next as you verify the existing client information. 
 
9. Enter Session Information as needed. Click Next. 
 
10. Click on “Don’t create an invoice now” and click Next. 

 
 

 Here’s a Flash for You! 
 
If you want to create an invoice for this session, skip steps 10-12, and follow the 
steps outlined in “Working with Invoices.” 
 

 
 

11. If you want to modify or view either the session or client information, select them. 
 
12. If you don’t want to print the session confirmation, you must click in the Print 

Session Confirmation check box to de-select it.  Click Finish. 
 

Creating a Session for a New Client 
 
1. To find the time and date, refer to the topic “Features of the Calendar.” 
 
2. When you have located the desired time and date, double-click on it.  A 

scheduling wizard will pop up to walk you through the scheduling steps.   
 

3. The default option is already set to “Create a Session for a specific client.”  Click 
Next. 

 
4. Click in “Create a new client” radio button.  Click Next. 
 
5. Fill in the client’s information and continue clicking Next. 
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 Here’s a Flash for You! 
 
See the topic “Features of the Client Information Screen” for more details 
regarding other client features. 
 

 
 
6. Enter session information as needed.  Click Next. 

 

 Here’s another Flash for You! 
 
See the topic “Features of the Sessions Information Screen” for more details 
regarding sessions. 
 

 
 

7. Click on “Don’t Create an Invoice Now” and click Next. 
 
 

 Here’s yet another Flash! 
 
If you want to create an invoice for this appointment, skip steps 7 and 8, and 
follow the steps outlined in the topic, “Working with Invoices”. 
 

 
8. Click Finish to open the session and client screens for modification, or de-select 

either or both.  Click Finish. 
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 Let’s Talk Clients, Shall We? 
 

A client record contains all the standard information regarding a customer, such as 
his/her address, phone number, client number, etc., but also the client’s e-mail address, 
family members and booking preferences.  A client can either be a current customer, a 
former customer or a prospect.  By utilizing the client groups classifications, you can 
easily change the type of client.  Using marketing plans to track your clients’ interests will 
allow you to target your marketing and increase sales.  If you need to know something 
about your client, pull up the Client Information screen. 

 

 Pathways to Success  
 
Remember, the more client information you fill in such as birthdays, 
anniversaries, etc., the more data is available for your marketing and client base 
analysis.  Don’t forget to ask your new clients where they heard about you so you 
can complete the “Lead Source” section.    
 

 

Features of the Client Information Screen 
 
Now it’s time to break down the Client Information Screen.  This screen is used to 
store all pertinent client information and to display other related information for this 
client from other screens.  Some of the client information stored here includes phone 
numbers, address, family members, client groups this client belongs to, and 
marketing plans in which this client is participating.  All phone calls, appointments, 
sessions, invoices, and payments related to this client are also listed on one of the 
detail tabs.  New phone calls, appointments, or sessions can also be created for this 
client from this screen by clicking on the appropriate button on the tool bar.   

 
The client screen is divided into four different sections. 

 

 
The Client Information Screen 
 

   
1. Menu Bar Section.  The Three menu choices are File, Edit and New.  

 
•  File Menu.  From the File menu you can save, delete and print the client 

records as well as exit the client screen. 
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1. Save.  To save the client record. 

•  You can just save the record by choosing Save 
               -Or- 

•  You can save the record and close the client screen by clicking Save 
and Close 

 -Or-  
•  You can save the record and get a blank screen to add another client 

record by clicking Save and New.   
 
2. Delete.  To delete a client record, bring up the record you want deleted 

and then choose the Delete option from the File menu. 
 
3. Acquire/Preview Client Image.  Use these features to acquire or to 

preview an image of this client.  See the Working with Digital Imaging 
section and the Pictorial Directory in the Reports section for more 
information. 

 
4. Print Mailing Label.   Use this feature to print a mailing label showing 

the client’s name and address for this client. 
 

 Here’s a Flash for You! 
 
If you want more options printing a single label, see the Company Preferences, 
Reports tab, and set the Single Mailing Label to Prompt for Printer. 
 
 

5. Print Account Label.  Use this feature to print an account label showing 
the client’s name, address, phone number, and client number for this 
client.   

 
6. Print Form Letter.  Use this feature to print a custom form letter or 

contract specific for this client. 
 
•  Edit Menu.  From the Edit menu you can Cut, Copy and Paste selected text 

to and from the clipboard. 
 
1. Cut.  You can cut text by highlighting the text you want to cut and then 

choosing Cut from the Edit menu. 
 

2. Copy.  You can copy text by highlighting the text you want to copy and 
choosing Copy from the Edit menu. 
 

3. Paste.  You can paste previously cut or copied text from a large variety 
of applications by first cutting or copying the text and then placing your 
cursor in the desired location in the Client record and choosing Paste 
from the Edit menu. 
 

•  New Menu.  From the New menu, you can add a New Appointment, a New 
Call or a New Session. 

 
1. New Completed Call.  To record a new call that has already been 

completed, choose New Completed Call from the New menu. 
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2. New Future Call. To add a new call to be completed in the future, 

choose New Future Call from the New menu. 
 

3. New Appointment.  To add a new linked appointment for this client, 
choose New Appointment from the New menu. 

 
4. New Session. To add a new session, choose New Session from the 

New menu. 
 

5. New Invoice. To add a new invoice, choose New Invoice from the New 
menu. 

 
6. New Email.  To send a new email to this client, choose New Email from 

the New menu.   
 

2. Toolbar Section.  Many of the same features available through the drop-
down menus are also available here on the toolbar.  If you’re not sure what 
a certain button is for, hold your mouse over the button and wait for a tool tip 
to be displayed. 

 
3. Header Section.  The main client information is visible here, including client 

name, phone numbers and a flashing Call Warning (see below for more 
details on Call Warnings.) 

 
4. Detail Section.  Detailed information about the client can be found here.  

Each tab holds its corresponding information about the client. 
 

•  General Tab.  From the General tab you can view or enter the client’s 
address, including Country and E-mail address, their anniversary and birth 
dates, as well as the contract date, client number and any call warning 
messages they may have.  This is where information about the clients’ 
relatives is located as well.  There is a check box for Saturday only. 
 
1. Contract Date.  If your studio requires clients to sign a contract, use this 

field to record when the contract was received. 
 
2. Call Warning.  Call Warnings are messages that appear on the Client 

Screen alerting users to special instructions, such as “This is a surprise 
party—don’t talk to spouse.”  If there is a call warning for a client, it will 
appear next to the phone number anywhere it is listed in Portrait One 
Manager.   
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 Here’s a Flash for You! 
 
Have you ever wished you or another employee knew a key piece of information 
about five minutes earlier than they did?  Our Call Warning feature is a great 
feature to inform you of key information as soon as you pull up a client record.  
Anytime Portrait One Manager displays a client’s name and phone number, it will 
also display the call warning in bright red flashing letters.  Here are some sample 
call warnings: 
 
Works nights, call after 5! 
Don’t talk to husband, it’s a surprise! 
Great client, take good care of! 
Difficult client, don’t schedule anything! 
 

 
 
3. Family Members.  When you double-click in this window, a new screen 

appears.  This is the Family Members Screen.  Here you will enter the 
name of the family member, the relationship and birthday along with their 
phone numbers and E-mail addresses.  To add a new family member, 
enter the new family member information and then click Add.  To modify 
an existing family member, simply click the desired family member from 
the list, modify the information, and click Add.  When you’re finished 
entering all family members and their information, click the button labeled 
Close.  

 
4. Lead Source.  Use the Lead Source field to record how this client heard 

about you (What is the source of this lead?).  This information can be 
critical in reviewing sales analysis reports. 

 
5. Client Number.  Portrait One Manager will automatically assign the 

Client Number, however, you can modify the number to another UNIQUE 
number. 

 
6. Saturday Only.  The Saturday only check box can be used to note 

which clients prefer to book sessions or appointments on Saturday only. 
 

 
•  Custom Tab.  Portrait One Manager gives you ten customized fields that you 

can use for whatever you want.  You can define how these fields are labeled 
in the Company Preferences, Clients tab. 

 
•  Groups Tab.  The Groups tab lists all of the available Groups in the left pane 

and all of the Groups that the client belongs to in the right pane.  “Groups” is 
a great way to maintain your client list.  You can manage your clients by 
categorizing them into groups such as high school, prospect, portrait client, 
wedding client, commercial client, etc.  Other Groups might include wedding 
or possibly troublesome clients you would rather not have back. (See the 
client tab portion of the section labeled “Company Preferences” for details on 
how to add, delete and modify your Groups.) 
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•  Marketing Plan Tab.  The Marketing Plan tab lists all of the available 
Marketing Plans in the left pane and all of the Marketing Plans that the client 
belongs to in the right pane.  “Marketing Plans” is a great way to keep your 
clients informed of your studio’s various promotional events.  Marketing plans 
also remind the clients of special events in their lives for which they may 
desire photos.  Once you’ve discovered your client’s interests, use this 
section to note those interests on the client’s record.  For date sensitive 
events, (i.e. Birthdays), Portrait One Manager will automatically create the 
call record x number of days prior to the special date. (The number of days is 
set by the user in the user preferences.  See the section labeled “Features of 
the Company Preferences Screen” for details.) This allows you to call the 
client, remind him/her of the special date, and book the session.  Non date-
sensitive events can be filtered later to generate the phone calls, e-mails or 
perhaps to generate the mail merge.   (See company preferences section 
labeled “Features of the Company Preferences Screen” for information on 
setting up the marketing plans.) 

 

 Pathways to Success  
 
Marketing Plans can be a key to the success of your studio.  If you use nothing 
else in Portrait One Manager, use this feature.  Using it can significantly increase 
your sales revenue.  For example, if you have a few empty time slots for 
sessions in a few days, you could use Portrait One Manager to find those clients 
who have already indicated an interest in conducting a Fall Colors session.  Find 
those clients, call them up, and book those sessions.  Be creative in how you use 
this feature, and be more successful. 
 
 
•  Phone Call Tab.  The Phone Call tab lists all phone calls, completed or not, 

related to this client. 
 

1. Description.  A phone call description tells you what type of call to place 
to the customer, such as a reminder that their son’s birthday pictures 
need to be scheduled. 

 
2. Due Date.  The due date is the date that the call is to be made. 

 
3. Target Date.  The target date is only related to marketing plans and is 

the date for which the photography session is planned. 
 

•  Appointments Tab.  The Appointments tab lists all appointments, completed 
or not, related to this client.  To view the complete details of the appointment, 
double-click on it in the list.   
 
1. Appointment Description.  An appointment description tells you why 

you have set up the appointment.  It could be something like “wedding 
consultation with Bill and Sue to finalize session time”.  This is displayed 
on the calendar browse screen. 

 
2. Appointment Date.  The Appointment Date is the date that the 

appointment is to take place. 
 
3. Appointment Type.  An appointment type would be something like 

“lunch appointment”.   
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•  Sessions Tab.  The Sessions tab lists all sessions, completed or not, related 

to this client. 
 

1. Date.  This is the date the session is to be held. 
 
2. Type.  This is the type of session being held.   

 
3. Description.  The session description tells you why you have set up the 

session.  It could be something like “Johnson family portrait”. 
 

4. Status.  This is where the session is currently within the production 
cycle. 

 

 Here’s a Flash for You! 
 
A session will remain open or active until all session activities have been 
completed.  Even after the actual photography portion of a session is completed, 
still other events may be outstanding.  Use the Session Status Maintenance List 
to setup your session statuses. 
 

 
•  Invoices Tab.  The Invoices tab lists all invoices generated for this client. 

 
1. Invoice Number.  The invoice number is assigned by Portrait One 

Manager but is modifiable.   
 
2. Invoice Date.  The invoice date is the date that the invoice was created. 
 
3. Invoice Total.  The invoice total is the total for that invoice. 
 
4. Amount Paid.  The amount paid is how much has already been paid 

toward that invoice. 
 
5. Balance Due.  The balance due is the amount still owed for that invoice. 

 
•  Production Tab.  The Production Tab is used to quickly find the status of an 

order that is in production.   
 
•  Summary Tab.  The Summary tab lists three types of detail.  These are 

Dates, Financial Status and Financial Transaction History. 
 
1. The Dates Section.   

 
a. Create Date.  The Create date is the date that the client record was 

created. 
 
b. Last Session.  The Last Session date is the date that the client was 

most recently in for a session. 
 
c. Last Call Date.  The Last Call date is the date that the client was 

most recently called on the phone. 
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2. The Financial Status Section.   

 
a. Sales Figures.  The sales figures are split into Lifetime Sales and 

YTD Sales.  Lifetime sales are those sales that have been recorded 
since you’ve started using Portrait One Manager for this client.  YTD 
sales are those sales that have been recorded since January 1st of 
this year.  The sales figures are also split into Session Sales and Bill-
To Sales.  For most clients, these numbers are the same.  Session 
sales are all the sales made where this client is the client being 
photographed.  Bill-to sales are all the sales made where this client 
is paying the bill.  An example may be a wedding couple is the 
session client, but the bride’s parents are paying the bill and 
therefore they are the bill-to clients. 

 
b. Open Balance.  Open Balance is the total of the invoices Not Yet 

Due and Past Due. 
 
c. Not Yet Due.  Not Yet Due is a total of all invoices that have been 

created for this customer that have not yet come due. 
 
d. Past Due.  Past Due is a total of all invoices that have come due but 

remain unpaid. 
 
3. The Financial Transactions History Section.  The Financial 

Transactions History Section lists individually the date, description and 
amount of all of the invoices, credit memos, payments, and refunds for 
this client in chronological order.  Most recent on top.  Double-click on 
any payment or invoice to bring it up and view all of its details. 

 
•  Notes Tab.  The Notes tab is a memo field where you can enter any notes 

about the client you need to. 
 

 Pathways to Success  
 
Have you noticed our waving flags yet?  Throughout Portrait One Manager, you 
may see a red or yellow waving flag.  Obviously, this is something important that 
you should pay attention to.  Perhaps the client has an outstanding invoice and 
owes you money, the client has an overdue phone call, or some notes should be 
looked at on the notes tab.  Allow Portrait One Manager ensure that you and your 
staff don’t overlook key pieces of information when working with your clientele. 
 

 
 

Adding New Clients 
 
If all you need to do is enter a new client, click File ⇒  New Client (or Ctrl-N) from any 
Browse Screen.  This launches the Client Wizard to take you step by step through 
entering a new client into your database.  Begin the entry of information.  After each 
page, click Next to advance through the New Client Wizard.  See the “Features of the 
Client Information Screen” for more detailed information. 
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The Client Wizard Screen 

 
 

 Here’s a Flash for You! 
 
Advanced users may choose to create a new client directly in a Client 
Information screen.  To disable the new client wizard, go to User Prefs.) 
 

 
 

Finding Existing Clients 
 
Change to the Client Browse Screen using the Browse Menu (or click View ⇒  Client or 
F3).   
 
 

 
The Client Browse Screen 
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Set the Search Criteria in the upper right corner and press Enter.  All clients matching 
your request will be shown. 

 

 Here’s a Flash for You! 
 
Just type in the first couple of characters and Portrait One Manager will display 
all clients with names beginning with those characters.  Example, type in “Jo” will 
bring up all customers with the name of Johnson, Jones, Jordan, etc.  
 
 

 
Click on one of the column headers and it will sort the list in ascending order.  Click again 
and it will sort in descending order.  
 
Click on the client that you wish to view, and then double-click on it to open the Client 
Information Screen.  You can then proceed to view, modify, or delete any information you 
want. 
 

Deleting Clients 
 

1. To find the client you want to delete, follow the steps outlined in the topic “Finding 
Existing Clients”. 

 
2. At the client screen with the desired client active, click on the Delete icon from 

the toolbar.  This will remove the entire client record from the database. 
  

 Here’s a Flash for You! 
 
Clients with session invoice, appointment or phone call records cannot be 
deleted. 
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Features of the Session Information Screen 
 

The Session Information Screen is used to store all pertinent session information and to 
display other related information regarding this session from other screens.  Some of the 
session information stored here includes session date, time, location, photographer, 
assistant, and participating family members.  All phone calls, invoices, and production 
information related to this session are also listed on one of the detailed tabs.  New phone 
calls and invoices can also be created for this session by clicking on the appropriate 
button on the tool bar.  In addition, all post session production information related to this 
session can also be accessed from this screen.  To launch the Session Information 
screen, double click on any session from the Session Browse screen.  The Session 
screen is divided into four sections:  

 

 
The Session Information Screen 

 
1. Menu Bar.  The four menu choices are File, Edit, Action and New.  

 
•  File Menu.  From the File menu you can save, delete and print the Session 

records as well as exit the Session screen. 
 
1. Save.  To save the Session record: 

•  You can just save the record by choosing Save 
-Or- 
•  You can save the record and close the Session screen by clicking 

Save and Close 
-Or-  
•  You can save the record and get a blank screen to add another 

Session record for the same person by clicking Save and New.   
 
2. Delete.  To delete a Session record, bring up the record you want 

deleted and then choose the Delete option from the File menu. 
 

3. Acquire Images.  To create jpeg previews of all the images taken for 
this session, use the Acquire Images feature.  Images are then available 
for preview on the Images tab, available for a slide show, and then 
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available for ordering with a digital invoice.  See the section on Working 
with Digital Imaging for more information. 
 

4. Print Session Confirmation.  Use this feature to print a Session 
Confirmation for this client.  It’s recommended that you print two copies, 
one for the client, and one for your records. 
 

5. Print Contact Sheet.  Use this feature to print a Contact Sheet, which 
shows all the images acquired for this session along with their image 
numbers. 
 

6. Print Mailing Label.   Use this feature to print a mailing label showing 
the client’s name and address for this session. 

 

 Here’s a Flash for You! 
 
If you want more options printing a single label, see the Company Preferences, 
Reports tab, and set the Single Mailing Label to Prompt for Printer. 
 
 

7. Print Account Label.  Use this feature to print an account label showing 
the client’s name, address, phone number, and client number for this 
session.   

 
8. Print Session Label.  Use this feature to print a session label showing 

the client’s name, client number, session date, time, type, photographer, 
and session number for this session.   

 
9. Print Form Letter.  Use this feature to print a custom form letter or 

contract specific for this session. 
 

10. Exit.  To exit the Session screen, choose Exit from the File menu. 
 
•  Edit Menu.  From the Edit menu you can Cut, Copy and Paste selected text 

to and from the clipboard. 
 
1. Cut.  You can cut text by highlighting the text you want to cut and then 

choosing Cut from the Edit menu. 
 

2. Copy.  You can copy text by highlighting the text you want to copy and 
choosing Copy from the Edit menu. 
 

3. Paste.  You can paste previously cut or copied text from a large variety 
of applications by first cutting or copying the text and then placing your 
cursor in the desired location in the Session record and choosing Paste 
from the Edit menu. 

 
•  Action Menu.  From the Action menu, you can show a slide show and make 

an archive CD. 
 

1. Change Slide Show Settings.  Use this feature to set your custom 
settings before starting a slide show. 
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2. Start Slide Show.  Use this feature to start the slide show. 
 

3. Stop Music.  Use this feature to stop the music after a slide show has 
completed. 

 
4. Make an Archive CD.  Use this feature to copy all the images related to 

this session to an Archived CD. 
 

•  New Menu.  From the New menu, you can add a New Call or a New Invoice 
for the current session record. 
 
1. New Completed Call.  To create a phone call that has already been 

completed, use this feature. 
 

2. New Future Call.  To create a phone call that needs to be made in the 
future, use this feature. 

 
3. New Appointment.  To create a new appointment record for this client, 

use this feature. 
 

4. New Invoice.  To create a new invoice for this session, use this feature. 
 

5. New Proof Order.  To create a new proof order for this session, use this 
feature. 

 
6. New Email.  To send a new email to this client, use this feature. 

 
2. Tool Bar.  Many of the same options from the Menu Bar can be found on the 

toolbar.  If you place your mouse cursor over the icon and hold it there, a text box 
will pop up (called a tool tip) with the name of the action that is tied to the icon.  
Simply click on the corresponding icon for the desired action you want to 
perform. 
 

3. Header Section.  This is where the client’s first and last name and client phone 
numbers are located or entered.  You will also see any Call Warnings for this 
session listed here.   
 

4. Detail Section.  This is where all of the details of the Session are located.  Each 
tab holds corresponding information about the client and session.  
 
•  General Tab.  From the General tab, you can view or enter the session 

description, the session type, the session date, the session start time, the 
session end time, the studio, photographer, the assistant and the outside 
location, if any. 
 
1. Session Description.  The Session Description is an optional field 

where you may enter a brief description about the session such as 
“Family Session”. 

 
2. Session Type.  The session type is chosen from a drop down list box.  

You may define as many session types as you desire.  Session Types 
are created under Maintenance, Item Maintenance.  Refer to the section 
on Application Maintenance for more information.   

 
3. Date.  The Date field is used to record the date on which the session will 

take place. 
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4. Start.  The Start field is used to record the time the session will begin.  

You can type this in or choose it from the drop down list box.   
 
5. End.  The End field is used to record the time that the session will finish. 

You can type this in or choose it from the drop down list box. 
 
6. Studio.  The Studio field is used to record which studio, if any, where the 

session will take place. You can type this in or choose it from the drop 
down list box. 

 
7. Photographer.  The Photographer field is used to record the name of 

the person taking the photographs. You can type this in or choose from 
the drop down list box. 

 
8. Assistant.  The Assistant field is used to record who, if any one, will be 

helping the photographer. You can type this in or choose from the drop 
down list box. 

 
9. Session Number.  The Session Number is a unique number that is 

assigned to each session by Portrait One Manager. 
 
10. File Number.  The File Number is a field that you can use to record any 

special number that your studio uses to track sessions. 
 
11. Date Booked.  The Date Booked automatically records the date this 

session record was created. 
 
12. Session Status and Due Date.  The Session Status and Due Date 

records the current status for this session, and the date this session is 
due to advance to the next stage.  See the section Working with Post 
Session Production Procedures for more information on this feature. 

 
13. Outside Location.  Outside Location is a field you can use to enter 

information as to the location of any sessions that will take place outside 
the studio.  This field will only appear if the Studio field is set to Outside 
Location. 

 
14. Confirmed.  Check the confirmed box if this session has been confirmed 

with the client.  Doing so will show the word ‘Confirmed’ on the calendar 
next to this session. 

 
•  Custom Tab.  Portrait One Manager gives you ten customizable fields for 

each session where you can enter whatever information you want.  To 
change the labels that appear next to each field, see the Sessions and 
Appointments tab in the Company Preferences. 

 
•  Wedding Tab.  If this session is a wedding, you can view or enter wedding 

information on this tab. 
 

1. Bride’s Name and Address. Use these fields to record the bride’s name 
and address.  If her address is the same as the main client, simply click 
the copy button next to these fields. 
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2. Groom’s Name and Address. Use these fields to record the groom’s 
name and address.  If his address is the same as the main client, simply 
click the copy button next to these fields. 

 
3. New Address. Use these fields to record the bride and groom’s new 

address.  If this address is the same as the main client, simply click the 
copy button next to these fields. 

 
4. Two Pre-ceremony Locations.  Use these fields to record one or two 

locations where pictures need to be taken prior to the ceremony. 
 

5. Ceremony Location.  Use these fields to record the location of the 
ceremony. 

 
6. Reception Location.  Use these fields to record the location of the 

reception. 
 

•  Senior Tab.  If this session is for a high school senior, you can view or enter 
senior information on this tab. 

 
1. School Name.  Select the school name for the list of High Schools.  All 

the remaining school-related fields will automatically fill in. 
 
2. Parent’s Name and Phone.  Enter the parent’s name and phone 

number here. 
 

3. Graduation Year.  Enter the year the client will be graduating here. 
 
•  Promotions Tab.  The Promotion tab is used to record one or more 

promotions that this session belongs to.    
 

  Pathways to Success  
 
Give some thought to how you could use Promotions to more effectively manage 
your business.  A promotion might be something like Santa Claus, Bunnies, Fall 
Colors, etc.  A promotion might also be something like Spring Sale, Two-for-One, 
Free Session Fee, or Referral Coupon.  If you’re recording this promotion 
information, then you’ll be able to generate analysis report information on the 
effectiveness of the various promotions that you run.  Never again will you 
wonder whether or not you should run a promotion again.  You’ll know what 
works and what doesn’t—profitwise. 
 

 
 
•  Participants Tab.  Use the Participants tab to record which family members 

will be participating in this session.   
 
•  Phone Calls Tab.  The Phone Calls tab displays all phone calls for this 

session, regardless of status.  To access the complete details of the phone 
call, double-click on the desired call record. 
 
1. Call Description.  The Call Description briefly explains the reason for 

the call. 
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2. Due Date.  The Due Date is the day the call is to be placed. 
 
3. Target date.  The Target Date is the day of the event you’re calling 

about.  For example, you might call on January 2nd (Due Date) for 
Valentine’s Day pictures (February 14th Target Date) . 

 
4. Completion Date.  The Completion Date is the date when the client was 

actually contacted. 
 
•  Invoices Tab. The Invoices tab lists the invoice number, invoice date, 

invoice total, amount paid and balance due.  This tab is identical to the one 
found on the client screen with the exception that the invoices listed here are 
only for this particular session.   
 
1. Invoice Number.  The invoice number is assigned by Portrait One 

Manager. 
 
2. Invoice Date.  The invoice date is the date that the invoice was created. 

 
3. Invoice Type.  The invoice types are Print Order, Session Fee, 

Estimate, and Credit Memo. 
 
4. Invoice Total.  The invoice total is the total due for that invoice. 
 
5. Amount Paid.  The amount paid is how much has already been paid 

toward that invoice. 
 
6. Balance Due.  The balance due is the amount still owed for that invoice. 

 
•  Production Tab.  The Production tab lists information related to production 

orders that have been created for this session.  Click the desired option 
button to display either proof orders or production orders.  This tab also 
records information about the number of proofs that have been created for 
this session, the location the proofs are stored in, or the CD the images have 
been archived to. 
 
1. Order Number.  The Order Number is the Number assigned by Portrait 

One Manager to the negatives when they are sent to the lab for 
developing. 

 
2. Date.  The Date is the date when the negatives were sent to the lab for 

developing. 
 
3. Vendor.  The Vendor is the name of the lab that will develop the 

negatives. 
 
4. Type.  The Type indicates what was ordered, either prints or proofs. 
 
5. Status.  The Status section indicates where in the process the order is 

currently. 
 
•  Images Tab.  The Images Tab displays thumbnail images of this session.  

See the section “Working With Digital Imaging” for further information. 
 

•  Notes Tab.  The Notes tab contains two notepads.  The Session Notes field 
is a place where you can enter any notes regarding a session.  The Status 
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Log Notes is a read-only field that displays a history of the statuses for this 
session. 

 

 Pathways to Success  
 
Have you noticed our waving flags yet?  Throughout Portrait One Manager, you 
may see a red or yellow waving flag.  Obviously, this is something important that 
you should pay attention to.  Perhaps the client has an outstanding invoice and 
owes you money, the client has an overdue phone call, or some notes should be 
looked at on the notes tab.  Allow Portrait One Manager to ensure that you and 
your staff don’t overlook key pieces of information when working with your 
clientele. 
 

 

Adding a New Session  
 
You may add a new session using either of the following options: 
 

1. From Calendar.  The most common method of entering a new session is directly 
off the Calendar Browse screen.  Double-clicking on an empty time segment will 
launch the scheduling wizard and walk you through the scheduling process for 
either a new or existing client.  (The scheduling wizard CANNOT be disabled 
through User Prefs.) 

 
2. From a Client.  An alternative method of entering a new session is directly off a 

Client Information screen.  Click New⇒  Session to launch a new session wizard.  
(Advanced users may choose to disable the session wizard through User Prefs.) 

 
 

Finding Existing Sessions 
 

1. From the Browse menu, choose Sessions.  This will bring up the Session Browse 
screen. 

 
2. Click and hold the down arrow next to the Last Name option of the search by list 

box and highlight the criteria by which you want to search. 
 

3. Release the mouse button and that option will then be displayed. 
 

4. Type in the criteria by which you want to search and press Enter.  (e.g.,  city 
name, if you chose to search by city.) 

 
5. All of the sessions that match the criteria which you have chosen will then be 

displayed.  Matching sessions can be sorted by clicking on any one of the 
column headings in the grid.  If you can’t find the desired session, use the scroll 
bar or choose another criteria to search by. 

 
6. When you find the correct session, click on the desired record and then double-

click on any field in that record to bring up the Session Information screen. 
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Deleting Sessions 
 

1. To find the Session you want to delete, follow the steps outlined in the topic 
Finding Existing Sessions.  Double click on the session to launch the Session 
Information Screen. 

 
2. At the Session Information screen, click on the Delete icon from the toolbar.  This 

will remove the entire Session record from the database. 
 

 Here’s a Flash for You! 
 
Sessions with invoices or production records cannot be deleted. 
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Features of the Appointment Information Screen 
 

The Appointment Information Screen is used to store all pertinent appointment 
information.  Some of the appointment information stored here includes the appointment 
description, the type of appointment, the location of the appointment, the appointment 
date and the beginning and ending times of the appointment.  From this screen, you can 
also set the default color in which the appointment type will be displayed on the Calendar 
Browse screen.  You can also access the Client Information screen by clicking on the Go 
To Client button on the tool bar.  Double-clicking on any existing appointment from the 
Calendar Browse Screen launches the Appointment Information Screen. 

  
 

 
The Appointment Information Screen 

 
 

1. Menu Bar.  The two menu choices are File and Edit.  
•  From the File menu you can save and delete the Appointment records as 

well as exit the Appointment screen. 
 
1. Save.  To save the Appointment record. 

•  You can just save the record by choosing Save 
                  -Or- 

•  You can save the record and close the Appointment screen by 
clicking Save and Close 

-Or-  
•  You can save the record and get a blank screen to add another 

Appointment record by clicking Save and New.   
 
2. Delete.  To delete an Appointment record, bring up the record you want 

deleted and then choose the Delete option from the File menu. 
 
3. Exit.  To exit the Appointment screen, choose Exit from the File menu. 

 
•  Edit Menu.  From the Edit menu, you can Cut, Copy and Paste selected text 

to and from the clipboard. 
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1. Cut.  You can cut text by highlighting the text you want to cut and then 

choosing Cut from the Edit menu. 
 
2. Copy.  You can copy text by highlighting the text you want to copy and 

choosing Copy from the Edit menu. 
 
3. Paste.  You can paste previously cut or copied text from a large variety 

of applications by first cutting or copying the text and then placing your 
cursor in the desired location in the Appointment record and choosing 
Paste from the Edit menu. 

 
2. Tool Bar.  The icons are shortcuts to all of the various menu choices.  If you 

place your mouse cursor over the icon and hold it there, a text box will pop up 
(called a tool tip) with the name of the action that is tied to the icon.  Simply click 
on the corresponding icon for the desired action you want to perform. 

 
3. Header Section.  The Header Section holds general client information such as 

client name, phone numbers, and call warnings, only if this appointment is linked 
to a client. 

 
4. Detail Section.  The Detail Section holds all of the appointment specific 

information.  This information is contained in two separate tabs, the General tab 
and the Notes tab.  

 
•  General Tab.  The General tab lists the description and type of appointment, 

the location of the appointment, the appointment date and the beginning and 
ending times of the appointment.  You can edit the color in which the different 
appointment types display on the Calendar Browse screen.  

 
1. Appointment Description.  An appointment description provides 

information on why you set up the appointment.  It could be something 
such as “wedding consultation with Bill and Sue to finalize session time”.   

 
2. Appointment Type. An Appointment Type would be something such as 

“lunch appointment”.  You can either type in the appointment type or 
choose it from the drop down box.  The drop down box can be edited 
from the Company Preferences screen.  Appointment types that are 
typed in are not added to the drop down list. This information is displayed 
on the Calendar Browse screen. 

 
3. User.  The User is the staff person with whom the appointment is made.   

 
4. Location.  The Location field indicates where the appointment is to be 

held, such as the “consultation room”.  Choose this field from the drop 
down box. 

 
5. Date.  The Appointment Date is the date on which the appointment is to 

take place.  You can type in the appointment date or choose it from the 
mini calendar.  A fast way to enter any date in Portrait One Manager is 
MMDDYY, or 051203 for May 12, 2003. 

 
6. Start.  The Appointment Start time is when the appointment begins.  You 

can type in the appointment start time or choose it from the drop down 
box. 
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7. End.  The Appointment End time indicates when the appointment ends.  
You can type in the appointment end time or choose it from the drop 
down box. 

 
8. Change Color.  Clicking on the Change Color button brings up a color 

pallet.  From this point, just click on the color you want the appointment 
background to be displayed in on the Calendar Browse Screen.  You can 
also design your own custom colors.  

 
9. Confirmed.  Check the confirmed box if this appointment has been 

confirmed with the client.  Doing so will show the word ‘Confirmed’ on the 
calendar next to this appointment. 

 
•  Notes Tab.  The Notes tab is a memo field where you can enter any necessary 

notes about the appointment. 
 

Add a New Appointment  
 
You may add a new appointment by using either of the following options: 
 

From Calendar.  The most common method of entering a new appointment is 
directly off the Calendar Browse screen.  Double-clicking on an empty time segment 
will launch the scheduling wizard and walk you through the scheduling process for 
either a new or existing client.  (The scheduling wizard CANNOT be disabled through 
User Prefs.)  If you want to create a simple, unlinked appointment on the calendar, 
simply click once on an empty time slot and start typing.  Press Enter when done and 
then resize the appointment box to change its start and end times. 
 
From a Client.  An alternative method of entering a new appointment is directly off a 
Client Information screen.  Click New⇒  Appointment to launch a new appointment 
wizard.  (Advanced users may choose to disable the appointment wizard through 
User Prefs.) 

 
 

Finding Existing Appointments 
 

Finding Appointments for a Specific Client 
 

1. From the Client Browse Screen, enter the client’s last name in the field provided.  
Press Enter. 

 
2. All matching records will be displayed.  If the client you are looking for is not 

visible, use the scroll bar to locate them.  You can sort the records by clicking on 
any column heading in the grid. 

 
3. Double-click in any field within the records row to bring up the Client Information 

Screen. 
 

4. Click on the Appointments tab.   
 

5. Locate the appointment and double-click on the appointment you wish to view. 
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Viewing Daily, Weekly, Monthly or Multiple Appointments 

 
1. To view a daily appointment schedule for a single user or location, go to the 

Calendar Browse Screen.  Find the date you want to view and click on it.  (For 
help on finding specific dates see the topic “Features of the Calendar.”) 

 
2. From the list of users, click on the desired user.  This will display their schedule 

in the time line.  Use the scroll bar to scroll up and down the timeline to view the 
day’s schedule.  To de-select a user, highlight their name in the user list and 
press Ctrl + left click. 

 
3. To view the schedule of a location only, Ctrl + left click on the current user name 

in the user list and left click on the location name from the locations’ list. 
 

4. Follow step 2 above to view the entire day and de-select the location. 
 

5. See the topic “Features of the Calendar” for help in viewing multiple days, weeks, 
multiple users and locations, etc. 

 
 

Deleting Appointments 
 

1. Follow the steps 1-5 outlined in the section titled “Finding Existing Appointments” 
to locate the desired appointment.  Double-click on the appointment you want to 
delete to launch the Appointment Information screen. 

 
2. When you have brought up the appointment you want to delete, click on the 

Delete icon from the toolbar. 
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Features of the Phone Call Information Screen 
 

The Phone Call Information screen is used to record a phone call that has already 
taken place with your client or that needs to take place with your client in the future.  
A call is considered completed once you fill in a Complete Date.  An easy way to 
complete a call is to click the Complete Call button on the toolbar.   
 

 
The Phone Call Information Screen 

 
1. Menu Bar.  The three menu choices are File, Edit, and Find.  
 

•  From the File menu you can save and delete the Phone Call records as well 
as exit the Phone Call screen. 
 
1. Save.  To save the Phone Call record. 

•  You can just save the record by choosing Save 
                  -Or- 

•  You can save the record and close the Phone Call screen by clicking 
Save and Close 

-Or-  
•  You can save the record and get a blank screen to add another 

Phone Call record by clicking Save and New.   
 
2. Delete.  To delete a Phone Call record, bring up the record you want 

deleted and then choose the Delete option from the File menu. 
 

3. Exit.  To exit the Phone Call screen, choose Exit from the File menu. 
 
•  Edit Menu.  From the Edit menu, you can Cut, Copy and Paste selected text 

to and from the clipboard. 
 
1. Cut.  You can cut text by highlighting the text you want to cut and then 

choosing Cut from the Edit menu. 
 

2. Copy.  You can copy text by highlighting the text you want to copy and 
choosing Copy from the Edit menu. 
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3. Paste.  You can paste previously cut or copied text from a large variety 
of applications by first cutting or copying the text and then placing your 
cursor in the desired location in the Phone Call record and choosing 
Paste from the Edit menu. 

 
2. Tool Bar.  The icons are shortcuts to all of the various menu choices.  If you 

place your mouse cursor over the icon and hold it there, a text box will pop up 
(called a tool tip) with the name of the action that is tied to the icon.  Simply click 
on the corresponding icon for the desired action you want to perform. 

 
3. Header Section.  The Header Section holds general client information such as 

client name, phone numbers, and call warnings about the client this phone call is 
linked to. 

 
4. Detail Section.  The Detail Section holds all of the phone call specific 

information.  This information is contained in two separate tabs, the General tab 
and the Notes tab.  

 
•  General Tab.  The General tab lists the description and type of the phone 

call, the user the call is assigned to, and any dates related to the call.   
 

1. Call Description.  Enter a description that you want to use to describe 
what this call was about or why you need to make this call in the future. 
(e.g. Call Mrs. Jones about Samantha’s birthday pictures.)   

 
2. Type.  Select a phone call type from the list.  You can alter this list on the 

Phone Call tab of the Company Preferences.  (e.g.  Prospect Call, 
Session Confirmation, Birthday Reminder, etc.)  

 
3. User.  Select the user that made this call or that should make this call in 

the future.   
 

4. Due Date.  If this phone call is to be made in the future, select or enter 
the date the call should be made on.   

 
5. Target Session Date.  If Portrait One Manager automatically creates this 

call as a birthday reminder, it will put the child’s birthday in this field.   
 

6. Complete Date.  Once a call has been completed, enter the completion 
date here.  An easy way to complete this field with today’s date is to click 
the Complete Call button on the toolbar. 

 
•  Notes Tab.  Enter any notes that you want to detail this phone conversation 

on the notes tab.   
 
 

Adding New Phone Calls 
 

1. From the Client Information or Session Information Screen, click the Create New 
Call button.  This will bring up the Phone Call Information Screen. 

 
2. Type in the description of the phone call. 

 
3. Choose the type of phone call from the type list box. 
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4. Choose the user that will make the call, if necessary, from the user list box. 
 

5. Edit the due date of the phone call, if necessary, or choose it from the calendar 
on the right.  The due date defaults to the current date. 

 
6. Enter the date the session is scheduled for in the Target Date field, if necessary. 

 
7. After the phone call has been placed, enter the completed date in the Complete 

Date field or click on the “Complete” button on the toolbar. 
 

8. Click on the Notes tab to enter any notes that you want to attach to this 
appointment.   

 
 

Finding Phone Calls 
 
 Finding a List of Today’s Uncompleted Calls 
 

To find a list of phone calls that must be made today, pull up the Phone Call 
Browse screen.  The screen defaults to show all of your uncompleted calls, in 
order of past due phone calls, today’s required phone calls and then a listing of 
all other uncompleted calls.  To view the detail of any phone call, click on the 
desired line to select the call and then double-click to open the Phone Call 
Information screen. 
 

Finding a List of Calls for an Individual Client 
 

To find a list of phone calls related to a specific client, open the client’s 
information screen and click the Phone Calls tab.  All completed and non-
completed calls related to this client will be shown.  Double-click on a line to view 
the Phone Call Information screen. 
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Digital Imaging Overview 
 

 
The Invoice Screen – Images Tab 

 
Portrait One Manager is more than just a great management software tool—it’s also a 
great imaging software.  Whether you shoot digitally or receive digital images from your 
lab, you can benefit from Portrait One Manager’ digital sales presentation, digital 
workflow management, and image management capabilities.  Here’s an overview of how 
to utilize the exciting tool of digital imaging with Portrait One Manager.  
 
1. Capture the images from the digital camera or receive a CD of images from the 

lab. 
 

2. Acquire the images into Portrait One Manager, a process where jpeg previews 
are created. 

 
3. Prepare and present the Portrait One Manager slide show with music to the 

client. 
 

4. While still in slide show mode, eliminate images that the client is not interested in 
using special hot-keys. 

 
5. Compare images side by side to help the client in their decision making process. 

 
6. Record the customer’s order information and any special notes for production. 

 
7. Confirm the order with the client and save it. 

 
8. Print an Invoice and an Image Detail Sheet for the client to take with them. 

 
9. Print an optional Contact Sheet of all the images for the client. 
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10. After the client leaves, convert the invoice into one or more Production Orders for 

each vendor. 
 

11. Use the Order Detail screen to open images up in Photoshop for retouching, 
cropping, or other enhancing. 

 
12. Use Portrait One Manager to create a Lab CD or use Portrait One Manager to 

FTP image files directly to the lab for printing. 
 

13. Use the Production Browse Screen to track the status of the order. 
 

14. Use Portrait One Manager to create an Archive CD and to create a catalog of the 
archived images for future retrieval. 

 
15. All preview images are permanently archived in Portrait One Manager for future 

viewing. 
 
 

Setup Portrait One Manager for Digital Imaging 
 

1. Select Maintenance⇒ Preferences⇒ Company Preference, and then 
click the Digital tab. 

 

 
 

2. Make sure the ‘Print Image Detail Sheet When Printing Invoices’ is 
checked. 

 
3. Select the appropriate option under ‘Use following method to determine 

image number from filename.’  See the following chart for examples: 
 

Option Filename Image Number 
Use First 3 Characters 013-S10001.jpg 13 
Use Last 3 Characters Larson004.jpg 4 
Use Ending Characters 
Starting at the Position 
Number 8 

S10001007.jpg 7 
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Use the Entire Filename 103.jpg 103 
 

4. Select your preferred Image Editor that you use to retouch images.  For 
example, use the Browse button to find PhotoShop.exe to launch PhotoShop.  
This option should be set on each workstation you use for retouching. 

 
5. Set the Raw Image, Hi-Res, and Preview image paths.  You need to give 

some thought to how you are currently storing, or how you want to start storing, 
your image files.  Here’s our recommendation!  First, select a shared drive to 
which all of your workstations have access.  We’ll call it the ‘S’ drive.  Next, 
create a folder for your images and label it ‘Images’.  Portrait One Manager will 
automatically create a folder in here for each session, and will also name it the 
session number.  For example: 
 

S:\Images\10001\ 
S:\Images\10002\ 
S:\Images\10003\ 

 
Next, Portrait One Manager will create three sub folders for each session—one 
for the Raw Images, one for the Hi-Res Images, and one for the Previews.  You 
can also create additional sub folders, if desired.  For each session, here’s an 
example for the sub-folder structure: 
 

S:\Images\10001\Raw\ 
S:\Images\10001\HiRes\ 
S:\Images\10001\Previews\ 

 
If you follow this recommendation, then this is how you should setup your 
preferences: 

 
Raw Image Path S:\Images\ 
Raw Image Sub-folder Raw\ 
Hi-Res Path S:\Images\ 
Hi-Res Sub-folder HiRes\ 
Preview Path S:\Images\ 
Preview Sub-folder Previews\ 

 
6. Click the Slide Show tab to set any title slides you want to show at the 

beginning or end of your slide shows.  The slides need to be jpegs, can be of any 
size, and should have a black background.  You can have between zero and four 
title slides at the beginning and between zero and two slides at the end. 
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7. Click OK to save and close the company preference. 

 
8. One more setting must be set in the user preferences.  Click 

Maintenance⇒ Preferences⇒ User Preferences.   
 

9. Make sure the Invoice Wizard checkbox is NOT checked.  Click OK to 
close the form.  

 
 
 

Acquiring Images 
 

1. Open the Session Information Screen for the session you want to work with. 
 

2. Click File⇒ Acquire Images.   
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3. Click the Copy From button and browse to the folder that contains the hi-res images.  
Once selected, you should see the first image in the preview window. 

 
4. Set the ‘Resize Images to Maximum of 600 Pixels’.  If your screen resolution is set to 

at least 1024 X 768, then you may want to increase the number to 700. 
 

5. Click Acquire to create the jpeg previews from the hi-res images.  When completed, 
click the Close button. 

 
6. Click the Images tab on the Session screen to preview the images. 

 
 
 

Presenting a Slide Show 
 

Slide shows can either be played from a Session Screen or an Invoice Screen.  More 
options are available from an invoice screen, such as the ability to arrange the images in 
a set order, hide undesirable images (not that you would have any, of course!), and use 
hot keys to record those images the client is or is not interested in. 

 
To play a slide show from a Session: 
1. Open the Session Information Screen for the session you want to work with. 

 
2. Click Action⇒ Change Slide Show Settings to set the music.   

 

 
 

3. Use mp3 files, wav files, or music directly off a music CD for your slide show.  
Mp3 and wav files are preferred.  You can select between zero and five songs for 
each slide show.  After the last song is played, the sequence is repeated.  Click 
OK to save and close the Slide Show Settings. 
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    ATTENTION!   
 
You must have the Windows Media Player installed to play music with your slide 
shows.  To install the Windows Media Player, visit: 
www.microsoft.com/windows/windowsmedia/players.asp.  
  
 

 
 
4. Click Action�Start Slide Show to start the show.  After the images are loaded, 

a black screen will be presented.   
 

5. Press the Space Bar to start the show and the music.  Press Esc to end the 
show.  Click Action�Stop Music to stop the music. 

 
To play a slide show from an Invoice: 
 
1. Open the Invoice Information Screen or create a new one for the invoice you 

want to work with.  
 

 Here’s a Flash for You! 
 
Maximize the Invoice to maximize your viewing area. 
 

 
2. Click the Images tab on the Invoice to view the images. 
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3. Right-click on undesirable images and select Hide. 

 
4. Drag-n-drop the remaining images into the order you want them to appear in the 

slide show. 
 

5. Set the music as described above. 
 

6. Click Action�Start Slide Show to start the show.  After the images are loaded, 
a black screen will be presented.   

 
7. Press the Space Bar to start the show and the music.  Use the following hot-keys 

during the slide show. 
 

HHoott  KKeeyyss  WWhheenn  aa  SShhooww  iiss  PPaauusseedd  
Esc End show and return to previous form 
Space Bar or P Start or play automatic show 
I Show/Hide image numbers 
H Hide the current image and advance to the 

next image 
Delete Permanently delete the current image file 
Home Move to the beginning of the slide show 
End Move to the end of the slide show 
Left Arrow, Up 
Arrow, or  
Page Up 

Move to the previous slide 

Right Arrow, 
Down Arrow,  
Or Page Down 

Move to the next slide 

HHoott  KKeeyyss  WWhheenn  aa  SShhooww  iiss  PPllaayyiinngg  
Space Bar Manually advance to next slide (once the 

transition is rendered) 
Esc End show and return to previous form 
I Show/Hide image numbers 
P Pause automatic show 
H Hide the current image 

 
8. Press Esc to end the show.  Click Action�Stop Music to stop the music. 
 
9. If you pressed ‘H’ during the slide show to hide any images, those images will 

now be hidden.  You’re now ready to proceed with the ordering process. 
 

Compare Images 
 

1. From the Invoice Images tab, click the first image to be compared. 
 
2. Hold down the Ctrl key and click the second image to be compared. You can 

compare between one and six images at a time.   
 

3. Click the Compare Images Button on the top right portion of this tab to compare 
the images. 

 
4. Press Esc to close the Compare screen and return to the Invoice screen. 
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Capture the Client’s Order 
 

1. From the Invoice Images tab, double-click the first image the client wants to 
order.  You’ll be automatically taken to the Image Detail tab for this image.  If 
you haven’t already done so, maximize the Invoice to maximize your viewing 
area. 

 

 
 
2. Select the products that the client wants to order for this image. 

 
3. From here you can go back to the Images tab to find the next image or click the 

Next and Previous buttons below the image to scroll through all selected images. 
 

4. After all products have been ordered, click the Order Detail tab to review all 
products and total dollar amounts. 
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The Invoice Information Screen – Order Detail Tab 

 
 
5. Click Save to save the invoice. Click the New Payment button to record the 

client’s down payment. 
 
6. After recording the client’s payment, click the Print button to print an Invoice and 

Image Detail Sheet for the client. 
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From this point, you can send your customer on their way as the session now 
moves into production. To make an archive CD of all the images related to this 
session, open the Session Information Screen and click Action>Make Archive 
CD.  A Production Order can also be created for this invoice, which will allow you 
to retouch your images, create a CD for the lab, or FTP the files directly to your 
lab for processing.  For further information on working with digital files in 
Production, see section “Working with Production Orders.” 
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Features of the Invoice Information Screen 
 

The Invoice Information Screen is used to store all pertinent invoice information and to 
display payment information regarding the selected invoice.  Invoice information includes 
invoice number, date, type, sales rep, due date, detailed sales information, payment 
information, and open balance information.   Use this invoice screen to quickly and 
efficiently generate an invoice to a client while that client is still in your studio or on the 
phone.  Later, after the client leaves or terminates the call, you’ll be able to enter a 
detailed production order, which is needed for the lab or other vendors.  This method 
allows you to invoice the client quickly and to receive payment immediately, if needed, 
but not make the client wait while all details needed for production are entered.  After an 
invoice has been generated, a payment can be received toward this invoice by clicking 
on the Payment button on the tool bar.  Invoices can easily be turned into a credit memo 
by changing the invoice type in the invoice header information.  Refunds can then be 
issued off the credit memo.  Refunds cannot be issued off an invoice.   

 

 Here’s a Flash for You! 
 
The Invoice Information screen is a wonderful tool to present images to clients 
and capture their digital order.  Whether you’re a film or digital studio, you can 
utilize these features to enhance your selling process and close additional sales.  
If you have digital image files of your sessions, acquire them into Portrait One 
Manager and start showing dynamic, sales effective presentations today.  (For 
information on acquiring your images, see the “Working with Digital Imaging” 
section.) 
 
 

 

 
  Invoice Information Screen. 
 

1. Menu Bar.  The Three menu choices are File, Edit and New.  
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•  File Menu.  From the File menu you can save, delete and print the Invoice 
records as well as exit the Invoice screen. 
 

1. Save.  To save the invoice record. 
•  You can just save the record by choosing Save 

                      -Or- 
•  You can save the record and close the invoice screen by clicking 

Save and Close 
-Or-  
•  You can save the record and get a blank screen to add another 

invoice for this session record by clicking Save and New.   
 

2. Delete.  To delete an invoice record, bring up the record you want deleted 
and then choose the Delete option from the File menu.  Once the invoice has 
been posted, it cannot be deleted. 
 

3. Print, Preview, and Export.  Use these features to print, preview, or export 
an Invoice or Image Detail Sheet 

 
4. Print Mailing Label.   Use this feature to print a mailing label showing the 

client’s name and address for this client. 
 

5. Print Account Label.  Use this feature to print an account label showing the 
client’s name, address, phone number, and client number for this client.  

 

 Here’s a Flash for You! 
 
If you want more options printing a single label, see the Company Preferences, 
Reports tab, and set the Single Mailing Label to Prompt for Printer. 
 

 
6. Print Form Letter.  Use this feature to print a custom form letter or contract 

specific for this client. 
 

7. Exit.  To exit the invoice screen choose Exit from the File menu. 
 
•  Edit Menu.  From the Edit menu you can Cut, Copy and Paste selected text 

to and from the clipboard. 
 
1. Cut.  You can cut text by highlighting the text you want to cut and then 

choosing Cut from the Edit menu. 
 
2. Copy.  You can copy text by highlighting the text you want to copy and 

choosing Copy from the Edit menu. 
 
3. Paste.  You can paste previously cut or copied text from a large variety 

of applications by first cutting or copying the text and then placing your 
cursor in the desired location in the invoice record and choosing Paste 
from the Edit menu. 

 
4. Delete Line.  Use this feature to delete a detail line from the invoice.  

Click on the desired line and make sure a yellow circle appears next to 
the line that you want to delete.  Either click Edit � Delete Line, press 
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Ctrl-D, or click on the yellow circle and click Delete Line from the pop-up 
menu. 

 
•  Action Menu.  Use the Action Menu to set slide show settings and to start a 

slide show. 
 

1. Change Slide Show Settings.  Use this feature to set your custom 
settings before starting a slide show. 

 
2. Start Slide Show.  Use this feature to start the slide show. 

 
3. Stop Music.  Use this feature to stop the music after a slide show has 

completed. 
 

•  New Menu.  From the New menu you can add a New Payment or Refund. 
 
1. New Payment or Refund.  To add a new payment or refund, choose 

New Payment or Refund from the New menu. 
 
2. New Production Order.  Use this feature to create a new Production 

Order for this Invoice.  See the section Working with Production Orders 
for more information on this feature. 

 
 

2. Tool Bar.  The icons are shortcuts to all of the various menu choices.  If you place your 
mouse cursor over the icon and hold it there a text box will pop up (called a tool tip) with 
the name of the action that is tied to the icon.  Simply click on the corresponding icon for 
the desired action you want to perform. 
 

3. Main Section.   This is where all of the details of the Invoice are located.  Each tab holds 
corresponding information about the invoice.  The main section has five tabs in it.   

 
•  General Tab.  This is where the client specific information, invoice 

information and notes about the invoice are located.  
 

1. Session Client.  This is the client in whose name the session was 
booked.  This field cannot be modified without changing the session. 

 
2. Bill-To Client.  This is the name of the person who is to be billed for the 

session.  The default is the same as the session client.  However, if you 
wish to change the bill-to client, click on the “Change Bill-To Client” bar 
and follow the steps below.  Note that a bill-to client MUST be entered in 
your database. 

 
a. Select the criteria or field on which you will search for the bill to 

client.  Press tab.   For example, to search by last name, press 
the down arrow and select “Client-Last Name” from the list.  

b. Type the selection criteria.  Press enter.  For example, to search 
for clients with the last name Anderson, you would type 
“Anderson” in this window.  To broaden your search criteria, type 
only part of the selection criteria.  For example, typing  “And” in 
this window would give you anyone whose last name BEGAN 
with “And”. 

c. The clients who match your criteria will be displayed.  Select the 
desired client by double clicking in the box to the left of the client 
name. 
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NOTE:  You may view the bill to client’s information by clicking on the bar 
labeled “View Bill-To Client”.   

 
3. Invoice information.   

 
a. Invoice Number.  The invoice number is a unique number assigned 

by Portrait One Manager when the invoice is created and cannot be 
modified. 

 

 Here’s a Flash for You! 
 
An invoice number is created once the invoice is saved.  Once a number is 
assigned, it will not be used again, even if the invoice later deleted. 
 

 
b. Invoice Date.  The invoice date is the date that the invoice was 

created and is entered by Portrait One Manager. 
 
c. Invoice Type.  The invoice type is a description of what the invoice 

is for. Portrait One Manager allows four different invoice types: 
Session Fees, Print Order, Estimate, or Credit Memo.  
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 Here’s a Flash for You! 
 
What do the different Invoice Types mean? 
 
An invoice for Session Fees is used to invoice the customer for the fees 
pertaining to shooting the Session.  When printing the invoice for Session Fees, 
the Invoice is printed as a Session Confirmation, which provides your customer 
with additional session information such as session date, time, and location.   
 
An invoice for a Print Order is where you charge your customer for products that 
they are purchasing from you.  An invoice for a Print Order can be converted 
into a Production Order for your lab or other vendors, which can then be 
tracked through the production phases. 
 
An invoice with an Estimate type can be used to provide your customer with an 
estimate for products.  An estimate will not be included in any sales or posting 
reports.  An estimate can later be converted into a Print Order simply by 
changing the Invoice Type 
 
An invoice with a Credit Memo type is used to give your customer a credit for 
any reason, or is also used to correct an invoice that may have been posted in 
error.  
 
 
 

d. Session Date.  The session date is the date of the actual 
photography session.  It is automatically supplied by Portrait One 
Manager if you are creating the invoice from the Session Information 
screen AND cannot be modified by the user.   If you are creating a 
client invoice (not linked to a session), this field is blank.   

 
e. Sales Rep. The sales rep is the individual that created the invoice.  

You can choose the sales rep from the drop down list.  
 

f. Payment Due Date.  The due date is the date that the invoice is due 
by.  You may click on the arrow to select the due date from the 
calendar, or simply type it in.  When typing in the due date, you do 
not need to enter slashes.  For example, 010100 would appear as 
01/01/2000. 

 
g. Approximate Delivery Date.  This field is optional.  Use the down 

arrow to select the delivery date from the calendar or enter it 
manually. 

 
h. Delivered Date.  This is also an optional field.  You may use the 

calendar or type it in manually.  If desired, you may set your invoice 
posting preferences to post only those invoices that have this date 
filled in, meaning that the order has been delivered. 

 
4. Notes.  The note section is a memo field and you can enter any 

information regarding the invoice that is needed.  This field will appear on 
the invoice print out. 
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•  Order Detail Tab.  Here is where the items that make up the invoice are 

located.  Also found here is a listing of payments and refunds for this invoice. 
 

 

 
 
1. Item Selection Window.  This is a list of all the invoice items available 

for this session type.   If this invoice is not linked to a session, then the 
items shown are based on the default price list for client invoices setup in 
the Company Preferences.  

 

 Here’s a Flash for You! 
 
You create your item lists and prices in the Price List Maintenance section of the 
program.  See the Price List Maintenance section of this manual to learn how to 
set up items and price lists. 
 

 
 
2. Invoice Detail.  This section lists the items for which the invoice is billing, 

a description of the item, the quantity, the unit price and the extended 
price.  Items can be selected in three different ways. 
 
a. Double-click on the item from Item Selection window 

 
b. Enter Item Number in Item field, and then press Tab. 

 
c. Or, enter a special item that has not been predefined in the price list 

by simply entering a description in the description column, no item 
number is necessary.  A quantity and price can be entered in.  

 
The yellow dot to the left of the line shows which item is currently 
selected.  To delete a line item, click on the yellow dot (make sure the 
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dot verifies that the desired line is selected) then click Delete from the 
pop-up menu.  You can also press Ctrl-D to Delete a line.  
 

3. Payments and Refunds.  This is where you can get a quick glance at 
the payment history of this particular invoice.  The list will include the 
date the payment or refund was made, the method of payment, and the 
amount paid.  Double click on any payment or refund in this area to bring 
up the payment screen.  (See the Section labeled “Features of the 
Payment/Refund Screen” for more details.) 

 

 

    ATTENTION!   
 
A Payment/Refund CANNOT be modified or deleted after they have been 
posted.  See Company Preferences for more information on posting. 
 

 
 
4. Charges and Totals.  This is where the summary information is located. 

 
a. Subtotal.  The subtotal lists the total of all of the items listed in the 

Invoice Detail section. 
 
b. Discount % and Discount Amount.  To discount the entire order by 

a fixed percentage, enter the percentage (e.g., 10% is entered as 10) 
in the window to the left of the Discount Amount line.  The amount of 
the discount is automatically calculated and displayed.   

 
c. Sale Tax Rate.  The sales tax rate applies the appropriate sales tax 

to the item based on how the sales tax tables were set up in the 
Company Preferences.  (See “Features of the Company 
Preferences” section for further details.)  Sales tax is not applied to 
non-taxable items. Sales Tax is applied after the discount is removed 
from the sub-total. 

 
d. Sales Tax Amount.  This is the total tax applied to the items of this 

invoice.  It is automatically calculated by Portrait One Manager.  It is 
recommended that you create an exempt rate of 0% in the tax table 
for tax-exempt orders.  

 
e. Shipping & Handling.  Enter the amount, if any, of the shipping and 

handling charges. 
 
f. Invoice total.  This is the total due for this invoice.  It is an automatic 

calculation. 
 
g. Total Payments.  This field will display the amount that has been 

paid against this invoice.  It is automatically updated as additional 
payments are made. 

 
h. Balance Due.  This field shows how much is remaining to be paid 

against this invoice.  It is automatically updated as additional 
payments are made. 
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•  Images Tab.   The Images Tab is used to show all the Images related to this 
session. This tab is a powerful tool to present images to a client and take 
their order for digital images.  See the section on Working with Digital Images 
for more information on this tab. 

 
•  Image Detail Tab.  The Image Detail Tab is used to show a single image 

and see all the products ordered for this image.  This tab is another tool to 
present images to a client and take their order for digital images.  See the 
section on Working with Digital Images for more information on this tab. 

 
•  Production Tab.  A list of all the Production Orders related to this Invoice is 

listed here.  See the section on Working with Production Orders for more 
information on Production Orders. 

 
 

Features of the Invoice Detail Screen 

The Invoice Detail Screen is used to enter further information regarding a single detail 
line of the invoice.  To get to the Invoice Detail Screen, click on the desired invoice detail 
line, click the yellow dot and then select Invoice Detail from the pop-up menu. 

 

 
 
 

1. General Tab   
 

•  Item Number.   The Item Number for this item is displayed here.  The invoice 
number can also be modified on the screen. 

 
•  Item Description.  The Item Description for this item is displayed here.  The 

invoice description can also be modified on the screen. 
 
•  Image Number.  The Image represents the Image or Frame for this print. 
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•  Quantity.  The Quantity field represents the number or quantity the customer 
is purchasing of this one item. 

 
•  Price.  The Price field represents the price the customer is being charged for 

this item.  The Price can be overwritten. 
 
•  Discount.  A Discount can be applied to this single line item.  Discounts can 

either be a flat dollar amount to be subtracted from the item, or a percentage 
that should be subtracted from the item. 

 
•  Extended.  The Extended is a calculation that cannot be modified.  The 

Extended calculation is the quantity times the price minus the discount. 
 
 

2. Options Tab   
 

•  Enhancement Level.   For each invoice detail line, you are allowed to 
choose one Enhancement from a predefined list.  An enhancement may be 
some form of retouching.  Depending on the enhancement chosen, the price 
for this line item will automatically be adjusted.  See the Item Maintenance 
Screen for further information on setting up Enhancements. 

 
•  Option Level.   For each invoice detail line, you are allowed to choose one 

Option from a predefined list.  An option may be a frame and mount option.  
Depending on the option chosen, the price for this line item will automatically 
be adjusted.  See the Item Maintenance Screen for further information on 
setting up Options. 

 
•  Composite Number.  Some labs offer composite options for you to sell your 

customers.  Use the composite number field to reference which composite 
option your client has chosen.  See Composite Maintenance in the Price List 
Maintenance section for further information on setting up Composites. 

 
•  Vendor.  Use this Vendor field to note which vendor or lab from which you 

are purchasing this item.  The vendor will default based on the vendor 
selected in the Item Maintenance Section. 

 
3. Notes Tab   

 
•  Notes.   Any additional notes regarding this line item can be added here.  

Examples may include additional cropping instructions. 
 
 

Add New Invoices 
 
 You have three ways to add a new invoice: 

 
1. During the Scheduling Wizard, you’ll be given the option to create an invoice.  

Choose Yes if you want to create a new invoice at that time. 
2. From a Session Information Screen, click New ⇒  Invoice 
3. From a Client Information Screen, click New ⇒  Invoice. 
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 Bugged About Something?? 
 
Does it matter if I create an invoice from the Session or Client Screens? 
 
YES, IT DOES!  An invoice should almost always be created from a Session 
Screen.  The only time you should create an invoice from a Client Screen is if this 
client is purchasing a product or service from you, but has not completed a 
session.  An example of a Client-based Invoice would be a customer walks in off 
the street and wants to purchase a frame.  When recording a Session-based 
Invoice, make sure you are creating the invoice from the actual session record 
this invoice pertains to. 
 

 

 Here’s a Flash for You! 
 
Advanced users can choose to disable the Invoice Wizard (See User 
Preferences section). 
 

 
 

Finding Existing Invoices 
 

From a Client Record – Click the Invoices Tab or the Summary Tab and double-click the 
desired invoice. 
 
From a Session Record – Click the Invoices Tab and double-click the desired invoice. 
 
From the Invoice Browse Screen – Select the Invoice Search Criteria, and the criteria 
to search for, and press Enter.  Click on the desired invoice to highlight it, then double-
click on it to open it. 
 

 

    ATTENTION!   
 
Invoices CANNOT be modified or deleted after they have been posted.  See 
Company Preferences for more information on posting. 
 

 
 

Deleting Invoices 
 

1.  Find the desired invoice to delete as described above and open it. 
 

2.  Click File ⇒  Delete or click the delete button on the toolbar. 
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 Here’s a Flash for You! 
 
Invoices with payment records cannot be deleted.  First delete any payment 
records, then delete the invoice. 
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Features of the Payment/Refund Information Screen 
 
The Payment Information Screen holds all of the information regarding a particular 
payment.  You can access this screen through the Summary tab on the Client 
Information Screen, or through the Payment and Refund portion of the Invoice 
Information Screen.  Double-click on the payment or refund for which you’d like 
information.  

 

 Bugged About Something?? 
 
What’s the difference between a payment and a refund? 
 
A payment is used to record the receiving of money from a customer.  A refund is 
used to record the paying of money back to a customer.  Both payments and 
refunds are entered using the same screen.  However, a payment is created from 
an Invoice and a refund is created from a Credit Memo. 
 

 

 
The Payment Information Screen 

 
1. Menu Bar.  The menu choices are File and Edit. 
 

•  File Menu. 
 

1. Save.  To save the payment record. 
•  You can just save the record by choosing Save, or press Ctrl + S 
-Or- 
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•  You can save the record and close the payment screen by clicking 
Save and Close, or press Ctrl + W 

-Or- 
•  You can save the record and get a blank screen to add another 

payment record by clicking Save and New, or press Ctrl + N. 
 

2. Delete.  To delete a payment record, bring up the record you want 
deleted and then choose the Delete option from the File menu, or press 
Ctrl + D. 

 
3. Print.  To print a payment record, bring up the record you want to print 

and then choose Print from the File menu, or press Ctrl + P. 
 
4. Exit.  To exit the Payment screen, choose Exit from the File menu. 

 
•  Edit Menu.  From the Edit menu you can Cut, Copy and Paste selected text 

to and from the clipboard. 
 
1. Cut.  You can cut text by highlighting the text you want to cut and then 

choosing Cut from the Edit menu, or press Ctrl + X. 
 
2. Copy.  You can copy text by highlighting the text you want to copy and 

choosing Copy from the Edit menu, or press Ctrl + C. 
 
3. Paste.  You can paste previously cut or copied text from a large variety 

of applications by first cutting or copying the text and then placing your 
cursor in the desired location in the payment record and choosing Paste 
from the Edit menu, or press Ctrl + V. 

 
2. Tool Bar.  The icons are shortcuts to all of the various menu choices  If you place 

your mouse cursor over the icon and hold it there, a text box will pop up (called a 
tool tip) with the name of the action that is tied to the icon.  Simply click on the 
corresponding icon for the desired action you want to perform. 

 
3. Detail Section.  This is where the payment or refund information is located (and 

entered when not using a wizard). 
 

a. Invoice Number.  This is the unique number that is assigned by Portrait One 
Manager to the invoice.  The payment or credit memo that you are creating 
will be applied to this number. 

 
b. Refund/Payment Date.  This is the date the payment or refund is applied to 

the invoice. 
 

c. Refundable.  If the payment is refundable click “yes”.  If the payment is not 
refundable, continue to the payment/refund method. 

 
d. Until Date.  This field only appears if you chose “yes” in the refundable 

section.  This is the date through which the payment may be refunded.  After 
this date, the payment is no longer refundable. 

 
e. Payment Method.  Type in the way the payment or refund is being made or 

choose it from the drop down list box.  This list cannot be modified by the 
user. 
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f. Credit Card Number.  Type in the customer’s credit card number.  This only 
appears if the transaction method selected is a credit card. 

 
g. Expiration Date.  Type in the expiration date found on the customer’s credit 

card.  This box only appears if the transaction method selected is a credit 
card. 

 
h. Customer Name, Address, Zip Code.  These fields are optional, although 

filling them in usually reduces your bank’s charge for processing a credit card 
through the program PC Authorize. 

 
i. Authorization Code.  If you are not using PC Authorize, you will not be able 

to enter information into this field. 
 

 Pathways to Success  
 
Increase the efficiency of your staff by using the optional credit card authorization 
software, PC Authorize.  Using this software allows all of your staff to authorize a 
credit card from any PC by clicking the Authorize button.  In addition, you could 
possibly be charged lower service charges by your credit card provider because 
of the additional customer name, address, and zip code information that is 
transmitted during the authorization process. 
 
 
j. Check Number.  Type in the number of the customer’s check.  This only 

applies if the payment method was by check. 
 

k. Payment Amount.  Type in the amount that was paid against this invoice, or 
refunded against this credit memo. 

 
 

Adding New Payments 
 

Creating a Payment from a Scheduling, Session or Invoice Wizard 
 
When choosing “Create a payment for this session or appointment”, you will be 
brought to the payment information screen.  Follow the steps below to create the 
payment or credit memo.  REMEMBER – refunds can only be created from a credit 
memo. 
 
1. Enter payment method or choose from the drop down box.   
 
2. If this is a credit card, fill in the appropriate information in spaces provided. 
 
3. If this is a check, fill in the check number in space provided. 
 
4. Enter payment/refund amount.  Click Next. 
 
5. If you want to modify the invoice, session, or client information, check the 

appropriate box and click Finish. 
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 Here’s a Flash for You! 
 
If you don’t want to use the Payment Wizard, you can disable it in the 
preferences section.  See the section labeled, “Features of the User Preferences 
Screen” for more details.  
 

 

Creating a Payment from Invoice Information Screen  
 
1. From the Invoice Browse Screen, find the Invoice for which the payment/refund is 

to be made. (See the Section labeled “Finding Existing Invoices” for more details.)  
Double-click on the desired invoice to launch the Invoice Information Screen. 

 
2. In order to create a refund, you must first create a credit memo to go with the 

original invoice. 
 

3. From the Invoice Information screen, click on the Create New Payment or Refund, 
or from the New menu choose Create New Payment or Refund. 

 
4. The Payment/Refund Wizard dialog box will appear. 

 

 Here’s a Flash for You! 
 
If you don’t want to use the Payment Wizard, you can disable it in the 
preferences section.  See the section labeled, “Features of the User Preferences 
Screen” for more details.  
 

 
5. If this payment/refund is refundable click the “Yes” radio button.  Then enter the 

Until Date in the field provided. 
 

6. Enter the payment/refund information and click Next. 
 

7. Click Finish and the payment/refund will print, or if you don’t want to print the 
payment/refund at this time, click the check box labeled “Print Receipt” to de-
select it and then click Finish. 

 

Finding Existing Payments 
 

Finding Existing Payments from the Client Information Screen 
 
1. From the Client Information screen, click on the Summary tab. 
 
2. Find the payment/refund in the Transaction History section and double-click on it 

to bring up the Payment/Refund Information screen. 
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Finding Existing Payments from the Invoice Information Screen 
 
1. From the Invoice Browse screen, find the invoice for this payment/refund.  (See 

the Section labeled “Finding Existing Invoices” for more details.) 
 
2. When you have located the correct invoice, double-click on it to bring up the 

Invoice Information screen. 
 

3. From the Invoice Information screen, click on the Detail tab. 
 

4. From the Payments and Refunds section (located in the lower left corner) 
double-click on the payment/refund to bring up the Payment/Refund Information 
screen. 

 
 

Deleting Payments 
 
1. Find the payment/refund you want to delete.  (See the section labeled “Finding 

Existing Payments” for more details.) 
 
2. From the Payment/Refund Information screen, click on the File menu and choose 

Delete, or press Ctrl + D, or click on the Delete icon. 
 

3. You will receive a message asking whether you are sure you want to delete this 
payment or refund.  If you are sure, click “yes”.  If you aren’t sure, click “no”. 

 
.



 Page 93 



 Page 94 

Post Session Production Tracking Overview 
 
Production Tracking allows you to track the status of the various “jobs” going on within a 
studio at any time.  The Production Browse screen and Production Status reports are 
great ways to learn the status of any particular order or to get an overview of your 
studio’s performance.   It’s frighteningly easy to allow an aspect of one of your jobs to slip 
off your radar screen and end up costing you time, frustration and possibly customer 
dissatisfaction.  Now you can make sure that you’re not falling behind, that jobs aren’t 
slipping through the cracks, that you’re not missing an important deadline, or that your 
vendors are delivering timely service. 
 
For digital studios, Production Orders have been designed to greatly assist in the 
preparation and processing of your digital orders.  Features such as links with 
PhotoShop, create Archive CDs, Create Lab CDs, and FTP Order to lab. 
 
The first step, as defined in this chapter, is to setup the various steps/stages that each of 
your “jobs” must go through in order to achieve completion. 
 
The following chapters will describe Proof and Production Orders in greater detail. 
 
Portrait One Manager allows you to customize all aspects of your post session production 
process.  Post session procedures are optional and you may use only those that are of 
benefit to you.  The three areas of post session production are:   
 
•  Session Status Maintenance 
•  Proof Order Status Maintenance 
•  Production Order Status Maintenance 
 
For each area, you must answer this question:  “What step or steps do my sessions need 
to go through?”  In each area of post session production, the user must define the steps 
in the cycle and the amount of time each step takes.  Phone call records can be 
generated for any step as the user desires.  Status reports are available for each step in 
each process.   
 
In addition, Portrait One Manager allows you to create proof and production orders based 
on your sessions and invoices.  This feature is discussed in greater detail in subsequent 
sections. 
 

 Here’s a Flash for You! 
 
Here are some important definitions: 
 
Proof Order Definition: A Proof Order is used to record film being sent to the 
lab for processing and proofs being returned to your studio.  Proof orders are 
created from the session record. 
 
Production Order Definition:  A production order is used to order prints from 
the lab or other products from your vendors.  Where an Invoice is used to record 
your customer’s order with you, Production Orders are used to record the orders 
you place with your labs/vendors to fulfill your customer’s order.   A single invoice 
may contain several production orders according to the number of vendors 
needed to fulfill the customer’s order.   
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Session Status Maintenance 
 

If you plan to track session status, you’ll want to begin by creating your own custom 
session status cycle.  On this screen your studio may create any steps involved in your 
session status cycle. To get to this screen, you may select Maintenance, List 
Maintenance from the main menu bar.  Or, you may select Maintenance, Preferences, 
Company Preferences, Miscellaneous tab.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.  Status List Section.  In this section you may view all the steps in the session status 

cycle, including the description of the step, the order of the step, how long the step lasts, 
and whether or not a phone call is required for the step.  Portrait One Manager provides 
you with a sample session status cycle.  You may modify or remove any step simply by 
highlighting it and clicking on Remove or Modify at the bottom of the window. 

 
2.   Status Definition Section.  In this section, the steps of your status are actually defined.  

To create a new step, click Add.  To modify an existing step, highlight that step and click 
Modify. 

 
•  Description.  Enter the name of the step you’re creating.   
 
•  Sort Order.  Enter the sequential number (1, 2, 3, 4, etc.) that corresponds to the 

place this step has in your session status cycle.  The steps you define will display 
based upon the order that you assign them.  Do not duplicate numbers in the sort 
order.  However, you may enter the steps in any order, as long as the Sort Order is 
properly defined. 

 
•  Typical Duration.  Enter the length of time—in business days—that this step usually 

takes.  This number is used to calculate the due date for the following step.  
However, it may be overwritten as you change the status of an individual session. 
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 Here’s a Flash for You! 
 
A business day means Monday through Friday, and does not include holidays. 
 
 

 
•  Initial/Final Status.  Your session cycle must have one step (and one step only) that 

you name as the initial status and one step (and one step only), that you name as the 
final status.  Select this status by clicking on the dot in front of it.  To change which 
step is the initial status, simply create or modify the NEW initial status and select the 
initial status button.  If another step had been defined as the initial status, Portrait 
One Manager will automatically move the initial status to the new step that you’ve 
selected.  The process works the same for changing whichever step is the final 
status. 

 
•  Phone call record.  Check this box if a phone call should be associated with this 

step.  Portrait One Manager will automatically create the phone call record for a 
session when this step is reached.  For example, if the client needs to be called when 
proofs are ready, a phone call record could be generated reminding you to call the 
client. 

 
•  Call Description. If the step requires a phone call, enter a call description here.  For 

example, "Proofs available for pick up" might be a good description for a phone call 
associated with a step called "Session Proofs Ready". 

 
•  Call Type.  Select a call type from the drop down menu.  Create and maintain phone 

call types from the main menu under Maintenance, List Maintenance, and Phone Call 
Types. 

 
•  User to Call. Assign the phone call to any employee by choosing that employee from 

the drop down list. 
 

Once the session cycle is defined, you may track each session you hold on the session 
information screen as shown below: 
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To change session status, click on the button to the right of the session status line.  The following 
screen appears: 

 
•  Date Completed.  Defaults to the current date.  The date completed can be changed if 

back dating or future dating a change. 
 
•  Change To Status.  Select the desired status from the drop down menu. 
 
•  Due Date.  The due date of the selected status will calculate automatically based on the 

time cycle defined in Session Status Maintenance.  You may overwrite the due date if 
desired. 

 
•  Current User.  Current user can be changed if someone other than the user currently 

logged into Portrait One Manager is completing this step. 
 

A history of all session status changes for the selected session is kept under the Notes 
tab on the session information screen.   
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Proof Order Status Maintenance 
 

 

 Here’s a Flash for You! 
 
Proof Order Definition: A Proof Order is used to record film being sent to the 
lab for processing and proofs being returned to your studio.  Proof orders are 
created from the session record. 
 
 

 
In the same way that you may define a session status cycle, you may also define a cycle 
for proof orders.  This is an optional feature and is not required by Portrait One Manager. 
 
Set up your proof order status cycle on this screen, found under Maintenance, List 
Maintnenance, Proof Order Status Maintenance (or under Maintenance, Preferences, 
Company Preferences, Miscellaneous).   

    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Status List Section.  In this section, you may view all the steps in your Proof Order 
Status cycle, including descriptions of each step, the order of each step, how long each 
step lasts, and whether or not a phone call is required for the step.  You may modify or 
remove any step simply by highlighting it and clicking on Remove or Modify at the bottom 
of the window. 
 

5. Status Definition Section.  In this section, the steps of the status are actually created.  
To create a new step, click Add.  To modify an existing step, highlight that step and click 
Modify. 
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•  Description.  Enter the name of the step you’re creating. 
 

•  Sort order.  Enter the sequential number (1, 2, 3, 4 etc.) that corresponds to the 
place this step has in your Proof Order Status Cycle.  The steps you define will 
display based on the order that you assign them here.  Do not duplicate numbers in 
the sort order.  However, you may enter the steps in any order, as long as the sort 
order is properly defined. 
 

•  Typical Duration.  Enter the length of time, in business days, that this step usually 
takes.  This number is used to calculate the due date for the step.  However, it may 
be overwritten as you change the status of an individual proof order. 

  

 Here’s a Flash for You! 
 
A business day means Monday through Friday, and does not include holidays. 
 
 

 
•  Initial/Final Status.   Your proof order cycle must have one step (and one step only) 

that you name as the initial status and one step (one step only), that you name as the 
final status.  Select Initial or Final status by clicking on the dot in front of it.  To 
change which step is the initial or the final status, simply assign that status to another 
step.  Portrait One Manager automatically updates all steps.   

 
•  Phone call record.  Check this box if a phone call should be associated with this 

step.  Portrait One Manager will automatically create the phone call record for a proof 
order when this step is reached.  For example, if the client needs to be called when 
proofs are ready, a phone call record could be generated reminding you to call the 
client. 

 
•  Call Description. If the step requires a phone call, enter a call description here.  For 

example, "Proofs available for pick up" might be a good description for a phone call 
associated with a step called "Proofs Received from Lab". 

 
•  Call Type.  Select a call type from the drop down menu.  Create and maintain phone 

call types from the main menu under Maintenance, List Maintenance, Phone Call 
Types. 

 
•  User to Call. Assign the phone call to any employee by choosing that employee from 

the drop down list. 
 

The status of individual proof orders can be changed in the Proof Order Information 
screen (see the section titled "Working with Proof Orders" for more information). 
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Production Order Status Maintenance 
 

 Here’s a Flash for You! 
 
Production Order Definition:  A production order is used to order prints from 
the lab or other products from your vendors.  Where an Invoice is used to record 
your customer’s order with you, Production Orders are used to record the orders 
you place with your labs/vendors to fulfill your customer’s order.   A single invoice 
may contain several production orders according to the number of vendors 
needed to fulfill the customer’s order.   
 
 

 
Portrait One Manager allows you to create a production order from its associated invoice.  
Your production cycle may be customized on the Production Status Maintenance screen.  
You may access this screen from the main Maintenance menu under List Maintenance or 
from Maintenance, Preferences, Company Preferences under the Miscellaneous tab. 
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1. Cycle Display Section.  In this section, you may view all the steps in your Production 
Order Status cycle, including descriptions of each step, the order of each step, how long 
each step lasts, and whether or not a phone call is required for the step.  You may modify 
or remove any step simply by highlighting it and clicking on Remove or Modify at the 
bottom of the window. 
 

2. Cycle Definition Section.  The steps of the cycle are actually created in this section.  To 
create a new step, click Add.  To modify an existing step, highlight that step and click 
Modify. 

 
•  Description.  Enter the name of the step you’re creating. 

 
•  Sort order.  Enter the sequential number (1, 2, 3, 4 etc.) that corresponds to the 

place this step has in your Production Order Status Cycle.  The steps you define will 
display based on the order that you assign them here.  Do not duplicate numbers in 
the sort order.  However, you may enter the steps in any order, as long as the sort 
order is properly defined. 
 

•  Typical Duration.  Enter the length of time, in business days, that this step usually 
takes.  This number is used to calculate the due date for the step.  However, it may 
be overwritten as you change the status of an individual production order. 

 
 
 

 Here’s a Flash for You! 
 
A business day means Monday through Friday, and does not include holidays. 
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•  Initial/Final Status.   Your production order cycle must have one step (and one step 
only) that you name as the initial status and one step (one step only), that you name 
as the final status.  Select Initial or Final status by clicking on the dot in front of it.  To 
change which step is the initial or final status, simply assign that status to another 
step.  Portrait One Manager automatically updates all steps.   
 

•  Phone call record.  Check this box if a phone call should be associated with this 
step.  Portrait One Manager will automatically create the phone call record for when 
this step is reached.  For example, if the client needs to be called when the order is 
completed, a phone call record could be generated reminding you to call the client. 
 

•  Call Description. If the step requires a phone call, enter a call description here.   
 

•  Call Type.  Select a call type from the drop down menu.  Create and maintain phone 
call types from the main menu under Maintenance, List Maintenance, Phone Call 
Types. 
 

•  User to Call. Assign the phone call to any employee by choosing that employee from 
the drop down list. 
 
Production orders are related to their associated invoice.  All status changes are 
made from that invoice.  The history of a production order is held under the Session 
Information screen, production tab, and also under the Client Information screen, 
production tab. 
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Features of the Proof Order Information Screen 
 

 

 Here’s a Flash for You! 
 
Proof Order Definition: A Proof Order is used to record film being sent to the 
lab for processing and proofs being returned to your studio.  Proof orders are 
created from the session record. 
 
 

 
The Proof Order Information Screen is used to store all pertinent proof order information 
and to display status information regarding this proof order.  Proof Order information 
includes vendor name and address, order date, order number, who completed the order 
and the status of the order. 

 

 
  The Proof Order Information Screen 
 
 
1. Menu Bar. The menu choices are File and Edit. 

 
•  File Menu. 

 
1. Save.  To save the proof record: 

•  You can just save the record by choosing Save, or press Ctrl + S 
-Or- 

•  You can save the record and close the proof order screen by clicking 
Save and Close, or press Ctrl + W 
-Or- 

•  You can save the record and get a blank screen to add another proof 
order record by clicking Save and New, or press Ctrl + N. 
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2. Delete.  To delete a proof order record, bring up the record you want 
deleted and then choose the Delete option from the File menu, or press 
Ctrl + D. 

 
3. Exit.  To exit the proof order screen, choose Exit from the File menu. 

 
•  Edit Menu.  From the Edit menu you can Cut, Copy and Paste selected text 

to and from the clipboard. 
 
1. Cut.  You can cut text by highlighting the text you want to cut and then 

choosing Cut from the Edit menu, or press Ctrl + X. 
 
2. Copy.  You can copy text by highlighting the text you want to copy and 

choosing Copy from the Edit menu, or press Ctrl + C. 
 
3. Paste.  You can paste previously cut or copied text from a large variety 

of applications by first cutting or copying the text and then placing your 
cursor in the desired location in the proof order record and choosing 
Paste from the Edit menu, or press Ctrl + V. 

 
2. Tool Bar.  The icons are shortcuts to all of the various menu choices.  If you 

place your mouse cursor over the sicon and hold it, a text box will pop up (called 
a tool tip) with the name of the action that is tied to the icon.  Simply click on the 
corresponding icon for the desired action you want to perform. 
 

3. Main Section.  The main section is where the proof order information is located 
and entered.  The proof order information consists of the name of the vendor(s), 
address, city, state and zip code as well as the vendor’s country.  Order 
information is also available, including the order date and number, the person 
who completed the order and the current status of the order. 

 
•  Vendor Information.  This can be selected from the drop down menu.  

Vendors are entered and maintained under Maintenance, Vendor 
Maintenance.  See the section on Application Maintenance for additional 
information. 

 
•  Order Date.  This date is automatically assigned by Portrait One Manager. 

 
•  Order Number.  While Portrait One Manager does not require this field, 

having an order number makes tracking a proof order much easier.  You can 
use your own numbering system or the order number provided by the lab.   

 
•  Completed By.  This field defaults to the current user, but can be changed 

by selecting any other user from the drop down menu. 
 

•  Status and Status Due Date.  You may track a proof order by assigning a 
status from the steps you defined in Proof Order Status Maintenance.  To do 
this, click on the button to the left of the line and select the proper status from 
the drop down menu.  The due date of the step you select is calculated 
based on the duration you defined for that step.  The completed date defaults 
to today's date, but may be changed if desired. The history of the proof order 
is kept under the notes tab.  You will always be able to see all the steps the 
particular order went through, along with the date the status was changed. 
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•  Vendor Invoice Number and Vendor Invoice Amount.  This field allows 
the recording of the amount your studio was charged for this proof order and 
the invoice number from your vendor. 

 
4. Detail Section.  The detail section is made up of four different tabs.  They are 

the Detail, Sessions, Notes, and Status Logs tabs.  On these tabs you will find 
the film and quantity information, as well as the sessions to which the order is 
linked and complete date tracking of status information and any pertinent notes 
for the proof order. 

 
•  Detail Tab.  The Detail tab is where the film information is kept. You define 

these film codes, types and descriptions in Maintenance, Preferences, 
Company Preferences, under the Miscellaneous tab. 
 
1. Film Code.  The film code is a unique identifier assigned to a specific 

type of film.  
 

2. Film Description.  The film description identifies the kind of film you are 
using, such as color or black and white. 
 

3. Film Type.  The film type identifies the type of film you are using, such 
as color negative. 
 

4. Film Format.  These formats are supplied by Portrait One Manager and 
selected from the drop down menu. 
 

5. Quantity.  The quantity is how many of a specific film you are using. 
 

•  Sessions Tab.  Portrait One Manager keeps a record of all the sessions to 
which this proof order is linked.  A proof order may be associated with more 
than one session.  For example, this would be the case if more than one 
client was photographed on a single roll of film. 
 

•  Notes Tab.  The notes tab is a memo field where you can enter any notes for 
this proof order.   

 
•  Status Logs Tab.  The Status Log is the place where the history of the proof 

order is stored, showing each step of the proof order cycle and the date it 
was completed. 

 
 
 



 Page 107 

Creating a New Proof Order 
 

Remember, a proof order is created from the Session Information screen, New menu. 
 

1. Identify the session for which you wish to create a proof order.  Go to the Session 
Information screen and select New, New Proof Order from the drop down menu. 

 
2. Decide whether this is a new proof order or an addition to an existing proof order.   If 

more than one client is on a roll of film, you’ll probably want to add to the proof order 
until you’ve accounted for all the sessions on that roll.  Or, if you have several rolls of 
film for several clients, you may want to put them all on one proof order. 

 
 
 
 

 
 
 
 
 
 

3. Fill in all the required order information.  Remember that you may assign an order 
number of your own choosing, and this will make retrieving the proof order easier.  
The proof order status will default to the first step you defined in proof order status 
maintenance. 

 
4. When you know the vendor’s invoice number and the invoice amount, you may enter 

that information here.  This is a reference field only and is not used in financial 
calculations. 

 
5. Fill in the Detail tab.  Click in the box under Film Type and select the film type from 

the list of films you defined in Maintenance, Preferences, Company Preferences, 
Miscellaneous.   The description will automatically fill in.  You may select Film Format 
from the drop down list provided by Portrait One Manager.  Enter the quantity for this 
type of film. 

 
6. The Sessions tab will be automatically updated to reflect the information on any and 

all sessions related to this proof order. 
 

7. Enter any additional information under the Notes tab.   
 

8. If you have more orders to create for this session, choose Save and New from the 
File Menu, or click on the Save and New icon on the toolbar.  Otherwise, choose 
Save or Save and Close. 

 
 

Finding an Existing Proof Order 
 

There are two ways to find an existing proof order in Portrait One Manager.  Once you 
locate the desired order, you may access it simply by double-clicking on the link. 
 
1. From the Session Browse screen, locate the session related to the proof order, and 

then look under the Production tab.  Make sure that you have the tab set to display 
proof orders. 

If you’re adding 
lines to an existing 
order, select that 
order by clicking 
the down arrow 
and highlighting 
the order. 
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2. From the Production Browse screen, locate the proof order and double click on it.  

You may also search for the proof order by entering the order number in the search 
box on the upper right and pressing Enter.   

 
 

Deleting a Proof Order 
 

1. Bring up the Proof Order you wish to delete.  (See the topic labeled “Finding an 
Existing Proof Order” for more details.) 
 

2. From the Proof Order Information Screen, click on the Delete icon or choose 
Delete from the File menu. 
 

3. If you are sure you want to delete this order, click the Yes button on the Deleting 
Order Warning box, otherwise click No button. 

 

Changing the Status of a Proof Order  
 

1. Select the proof order you want to change.  Refer to the section on “Finding an 
Existing Proof Order” for more information on how to select the proof order. 
 

2. Click the button next to the Status line.  Portrait One Manager will assume you 
wish to advance to the next status and fill in that information automatically.  If 
another status is desired, simply select it from the drop down menu. 

 
A proof order does not need to move through every status, nor does it need to move 
through the steps in order.  The user controls when status is changed, and the status to 
which the order is changed. 
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Features of the Production Order Information Screen 
 

 Here’s a Flash for You! 
 
Production Order Definition:  A production order is used to order prints from 
the lab or other products from your vendors.  Where an Invoice is used to record 
your customers order with you, Production Orders are used to record the orders 
you place with your labs/vendors to fulfill your customer’s order.   A single invoice 
may contain several production orders according to the number of vendors 
needed to fulfill the customer’s order.   
 

 
Production orders are created from an associated invoice.  When a client orders prints or 
other products, Production Orders can be generated automatically by Portrait One 
Manager or entered manually by the user. 

 

 
The Production Order Information Screen 

 
 
1. Menu Bar. The menu choices are File, Edit and Action. 

 
•  File Menu. 

 
1. Save.  To save the production order record. 

•  You can just save the record by choosing Save, or press Ctrl + S 
-Or- 

•  You can save the record and close the production order screen by 
clicking Save and Close, or press Ctrl + W 
-Or- 

•  You can save the record and get a blank screen to add another 
production order record by clicking Save and New, or press Ctrl + N. 
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2. Delete.  To delete a production order record, bring up the record you 
want deleted and then choose the Delete option from the File menu, or 
press Ctrl + D. 

 
3. Print, Preview, Export.  Use these features to print, preview, or export 

either a Work Order or a Purchase Order.  A Work Order is used for your 
own internal processing of a Production Order, while a Purchase Order is 
used to send to your vendor/lab for the ordering of prints or other 
products. 

 
4. Exit.  To exit the production order screen choose Exit from the File 

menu. 
 
•  Edit Menu.  From the Edit menu you can Cut, Copy and Paste selected text 

to and from the clipboard. 
 
1. Cut.  You can cut text by highlighting the text you want to cut and then 

choosing Cut from the Edit menu, or press Ctrl + X. 
 
2. Copy.  You can copy text by highlighting the text you want to copy and 

choosing Copy from the Edit menu, or press Ctrl + C. 
 
3. Paste.  You can paste previously cut or copied text from a large variety 

of applications by first cutting or copying the text and then placing your 
cursor in the desired location in the production order record and 
choosing Paste from the Edit menu, or press Ctrl + V. 

 
•  Action. 
 

1. Make Lab CD.  Use this feature to create a CD to send the order to your 
lab.  See the Make a Lab CD section later in this chapter. 

 
2. FTP Order to Lab.  Use this feature to FTP an order to your lab over the 

Internet.  See the FTP Order to Lab section later in this chapter. 
 

2. Tool Bar.  The icons are shortcuts to all of the various menu choices.  If you 
place your mouse cursor over the icon and hold it, a text box will pop up (called a 
tool tip) with the name of the action that is tied to the icon.  Simply click on the 
corresponding icon for the desired action you want to perform. 

 
3. Main Section.  The main section is where the production order information is 

located and entered.  The production order information consists of the vendor 
name, address, city, state and zip as well as the vendor’s country.  Order 
information is also available, including the order date and number, the person 
who completed the order and the current status of the order. 

 
 

•  Vendor Information.  This can be selected from the drop down menu.  
Vendors are entered and maintained under Maintenance, Vendor 
Maintenance.  See the section on Application Maintenance for additional 
information. 

 
•  Order Type.  You can define the order types by clicking Maintenance ⇒  List 

Maintenance ⇒  Production Order Types. 
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•  Order Date.  This date is automatically assigned by Portrait One Manager. 
 

•  Order Number.  While Portrait One Manager does not require this field, 
having an order number makes tracking a production order much easier.  
You can use your own numbering system or the order number provided by 
the lab.  Click the # button to have Portrait One Manager automatically 
assign an Order Number. 

 
•  Completed By.  This field defaults to the current user, but can be changed 

by selecting any other user from the drop down menu. 
 

•  Status and Status Due Date.  You may track a production order by 
assigning a status from the steps you defined in Production Order Status 
Maintenance.  To do this, click on the button to the right of the line, and 
select the proper status from the drop down menu.  The due date of the step 
you select is calculated based on the duration you defined for that step.  The 
completed date defaults to today’s date, but may be changed if desired. The 
history of the production order is kept under the Status Logs tab.  You will 
always be able to see all the steps that a particular order went through, along 
with the date the status was changed. 

 
4. Detail Section.  The detail section is made up of five different tabs.  They are the 

Detail, Invoices, Studio Notes, Vendor Notes and Status Logs tabs.  On these 
tabs you will find the film and quantity information as well as the complete date 
tracking of status information and any pertinent notes for the production order. 

 
•  Detail Tab.  The Detail tab is where a summary of order information is kept.  

More information about any line on the detail tab is available by clicking the 
Add button on the detail tab.  Highlighting the line and clicking the Edit button 
will open the Order Detail form for that line. 

 
•  Invoices Tab.  The Invoices tab contains a listing of every invoice related to 

this production order.  A production order can be related to more than one 
invoice. 

 
•  Studio Notes.  The Studio Notes tab contains notes needed within your 

studio to process the order. 
 

•  Vendor Notes.  The Vendor Notes tab contains notes that you want sent to 
your vendor to help them process the order. 

 
•  Status Logs.  The Status Logs tab contains historical information about the 

various steps this production order has gone through. 
 

 
 

Creating a New Production Order 
  

In Portrait One Manager, the production order is created from the invoice used to record 
the customer’s order.  A production order can be related to one client, or to several 
clients, if desired.  This depends upon how your studio sends information to your lab. 
 
The steps below outline how to create a new production order.  This is done from an 
invoice, so if needed, please refer to the section on creating an invoice to learn how 
invoices are generated. 
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1. Create or access the desired invoice.  This can be done from the Client 

Information Screen under the invoices tab, or from the Invoice Browse Screen, or 
from the Session Information Screen under the invoices tab. 

 
2. Click on New, New Production Order from the Invoice screen. 

 
3. Fill in the New Production Order Information screen.  

 
 

   
 

•  Step 1: Select the vendor for this production order.  If you select ‘Use all 
necessary vendors to fulfill this invoice’, Portrait One Manager will 
automatically create a separate Production Order for each vendor that is 
necessary to fulfill this customer’s order. 

 
•  Step 2: Decide if this will be a new production order.  If you are combining 

multiple customers’ orders into one production order, select the production 
order you have already started from the drop down menu. 

 
•  Step 3: Decide if you want to create the order manually or have Portrait One 

Manager do it for you.  If you ask Portrait One Manager to create the order 
for you, only those items assigned to the selected vendor will be added to the 
production order.  When you create an item, you assign a vendor to that 
item.  Here is where that information is used.  You may change the vendor 
for individual items on specific invoices.  See the sections on creating 
invoices and price list maintenance for more information. 

 
Click OK when you are done with these steps to move to the Production Order 
screen 

 
4. On the Production Order the vendor information should automatically be 

completed.  The order number usually comes off the bag or envelope provided 
by the vendor.  It is strongly recommended that an order number be used for 
ease in retrieving the production order at a later time.  Fill in any of the other 
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informational fields as desired.  (See the beginning of this section for more 
information about these fields). 

 
5. The status of the production order will automatically default to the first step in the 

cycle as you defined it in Production Status Maintenance.  (See the section on 
List Maintenance for more information). 

 
6. If you have asked Portrait One Manager to create the production order for you, or 

if you are adding to an existing production order, there will be lines appearing on 
the detail tab.  If you will be creating the order manually, the detail tab will be 
blank. 

 
7. To add a new line, click the new button.  To modify an existing line, highlight that 

line and click on Edit.  Either of these actions brings up the order detail screen. 
 
 

Completing a Production Order Detail Record 
 
If this Production Order has a type of Print Order, as defined in the Production Order 
Type Maintenance Screen, then you will see the following detail screen.  Otherwise, 
you will see a more basic, generic detail screen. 
 

 
 
 

1. Single Image or Composite.  If this product will contain only one image, 
select the Single Image option.  If this product will contain multiple images, 
click the Composite option.   
 

2. Image Number.  Enter an image number associated with this image. 
 

3. Raw Image Path.  Enter the path to the raw image file associated with this 
image.   
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4. Hi-Res Image Path.  Enter the path to the developed hi-res file associated 
with this image.   
 

5. Preview Image Path.   Enter the path to the preview jpg file associated with 
this image.   
 

6. Retouch Image Button.  Click the Retouch Image Button if you want to 
open the hi-res image in your image editor, like PhotoShop.  If you modify the 
image in any way, you can have Portrait One Manager create a new preview 
image by right clicking on the right hand image and clicking Make New 
Preview. 
 

7. Enhancements.  If this image needs to be enhanced in any way, use the 
Enhancement list to track these enhancements. Sample enhancements may 
include Fix stray hair, Remove facial blemish, Make Sepia, or Add logo.  
Enhancements must be predefined in the Item Enhancement Maintenance 
List. 

 
a. Description.  What do you call this enhancement in your studio? 
b. Vendor Description. What does your lab call this enhancement (if the 

lab is responsible to perform the enhancement)? 
c. Notes. Any special notes. 
d. Apply To All. Do you want this enhancement to apply to all products 

related to this image on this order? 
e. Studio Or Vendor. Who is responsible to perform this enhancement? 
f. Completed. Check this box, once the enhancement has been 

completed. 
 

 
 

8. Single Product or Multiple Products.  If you want just one product created 
from this image, click Single Product.  If you want more than one product 
created from this image, like an 8X10 and a 5X7, then click Multiple 
Products. 
 

9. Description.  How do you describe this product within your studio?   
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10. Vendor Description.  How does your lab/vendor describe this product?   

 
11. Composite.  If you are ordering a composite, use this field to select a 

predefined composite description from a list.   
 

12. Quantity.  How many of this product do you want to order?   
 

13. Notes.  Enter any special notes related to this product.   
 

14. Options.  If you are ordering any special options, like spray or mount 
options, use the Options List feature.  Options must be predefined in the Item 
Options Maintenance List. 

 
a. Description. What do you call this Option within your studio? 
b. Vendor Description. What does your lab call this Option? 
c. Notes. Enter any special notes related to this Option. 

 

 
 

15. Studio Notes.  Enter any special notes that you need within your studio to 
produce this product.   
 

16. Vendor Notes.  Enter any special notes that your lab/vendor may need to 
produce this product.   

 
 

Finding an Existing Production Order 
 
There are several ways to find an existing production order. 
 

1. From the Session Information screen, you may go to the Production tab, choose 
to display production orders, and double-click on the desired order. 
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2. From the Client Information screen, you may go to the Production tab, choose to 
display production orders, and double-click on the desired order. 

 
3. From the Invoice screen, you may go to the Production Tab and double-click on 

the production order desired. 
 

4. From the Production Browse screen, you may double-click on the production 
order desired.  

 
 

Deleting a Production Order 
 

1. Bring up the Production Order you want to delete.  (See the topic labeled 
“Finding an Existing Production Order” for more details.) 

 
2. From the Production Order Information Screen, click on the Delete icon or 

choose Delete from the File menu. 
 
3. If you are positive that you want to delete this order, click the Yes button on the 

Deleting Order Warning box, otherwise click No button. 
 
 

Changing the Status of a Production Order 
 

1. Select the production order whose status you wish to change.  Remember that 
the history for this production order is under the Status Logs tab. 

 
2. Click on the button to the right of the Status line.  The window below will appear. 

 

  
3.  Fill in the date the current step was completed.  The default is today's date, but 

you may override it if desired. 
 

4. Portrait One Manager will automatically advance the status to the next step and 
due date.  You may override this if desired. 

 
5. When all boxes are accurately filled in, click OK. 
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Making a Lab CD 
 

Use this feature to create a CD to send to your lab.  To use this feature, you must have a 
CD-writer installed on your PC, and you must have enabled the CD to be written to using 
a program like Roxio’s Direct CD.  To start the process of making a CD, click Action ⇒  
Make Lab CD to open the Make Lab CD dialog box.  Select any additional files to be 
included on the CD and remove any files from the list that should not be included on the 
CD.  In addition to including all necessary image files, the CD can also contain an Adobe 
PDF file of the order. Click the Make CD button to make the CD. 
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FTP Order to Lab 
 

Use this feature to FTP an order to your lab over the Internet.  To setup the FTP process, 
complete the FTP information on the Vendor Information Screen.  To begin the FTP 
process, click Action ⇒  FTP Order to Lab to open the FTP Order to Lab dialog box.  
Select any additional files to be included and remove any files from the list that should not 
be sent.  In addition to including all necessary image files, an Adobe PDF file of the order 
can also be sent to the lab.  Make sure you are connected to the Internet and click Start 
FTP. 
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Company Preferences 
 

The Company Preferences screen is where you can customize your installation of 
Portrait One Manager. 

 
 
1. Company Tab.  This is where the information about your company is kept.  

During the installation of Portrait One Manager, you were prompted to enter your 
company name.  What you entered will be defaulted into the field labeled 
Company Name.  This field is not modifiable.  If this name needs to be different 
you will have to reinstall Portrait One Manager using the correct name.  You will 
be able to enter and modify the rest of your company’s information.  You may 
also select a company logo by clicking on the Company Logo Bar and linking to 
an existing graphics file that contains your company’s logo.  The Studio Number 
is only used by Portrait One Manager Enterprise users. 
 

 
Company Preferences Screen – Company Tab 

 
2. Client Tab.  From the client tab you can set the default phone number types and 

default area code.  You can also modify the family member relationships, client 
groups and phone number types.  
 
•  Family Member Relationships Button. Click on this button to add, delete 

and modify the Family Member Relationships list box.   Family Member 
relationships define the relationship between an individual and the primary 
client. 

•  Client Groups Button.  Client groups are used to help categorize your 
clients.  A client can belong to any number of groups, or need not belong to 
any.  Client groups can be used to generate lists of clients for mailings, 
phone calls, promotions, etc. 

•  Lead Sources Button.  Lead sources help you to track the origin of new 
clients.  Maintain your list of lead sources here, then select the proper lead 
source when entering a new client record. 
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Company Preferences Screen – Clients Tab 

 
3. Scheduling Tab.   This tab is used to specify special options related to the 

calendar and scheduling. 
 

•  Appointment Options.  You may select the default color and length of 
time for an unlinked appointment as it will display on the calendar. 

•  Default Locations.  You may also select the default location for both a 
session and an appointment.  Defaults can be overridden at the time a 
session or appointment is made.   

•  Special Event List.  The Special Event List is to record holidays or 
special events that you want to appear with special headings and/or 
special open hours on the calendar.   

•  Studio Open Hours.  The Studio Open Hours section is used to define 
the hours your studio is opened.  These hours appear in a different color.  
However, sessions and appointments can be booked during both open 
and closed hours.  If a studio is closed all day long, set both the open 
and closed time to the same thing.  

 

 
Company Preferences Screen – Scheduling Tab 
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4. Marketing Plans Tab.  Enter any special promotions that your studio conducts 

through the Marketing Plan Maintenance section. For date sensitive Marketing 
Plans, such as a birthday reminder, select how far in advance to generate a 
phone call reminder and which user to assign the phone calls to.  As with client 
groups, clients may be part of any number of marketing plans. 

 

 
Company Preferences Screen – Marketing Tab 

 
5. Accounting Tab.  The accounting tab allows you to specify your accounting link 

options within Portrait One Manager. 
 
•  Accounting Method.  Choose the accounting method you will use.  

Remember, Invoices and Payments cannot be modified once they are 
posted.   
a. Cash Basis 1.  Invoices will be posted as revenue when the balance due 

is equal to zero. 
b. Cash Basis 2.  Invoices will be posted as revenue when the balance due 

is equal to zero AND the product delivery date has been filled in on the 
invoice. 

c. Accrual.  Invoices are posted and counted as revenue immediately 
when they are generated. 

 
•  Accounting Link.  Choose the software package you currently use, and type 

in the path to the folder that you want accounting files to be exported to (e.g., 
C:\ My Documents\).  Then, when you use the End of Day Posting Procedure 
to post invoices or deposits, Portrait One Manager exports data to the path 
you specified, in the proper format, for your accounting software to import. 

 
•  General Ledger Numbers.  This section allows you to set up and modify the 

default account numbers for your general ledger.  The account names may 
be alphanumeric, but be certain that they match EXACTLY the account 
numbers or names in your accounting software.  The accounts that we will be 
posting to are Cash, Credit Card Receivables, Customer Deposits, Sales Tax 
Payable, Shipping & Handling, General Sales and Discounts. 
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Company Preferences Screen – Accounting Tab 

 
6. Invoicing Tab.  Set your sales tax and invoicing options here.  
 

 
The Company Preferences Screen, Invoicing Tab. 

 
 
•  Sales Tax.  Clicking on the Sales Tax button will bring up the screen where 

all sales tax/VAT rates may be entered.  To add a new sales tax/VAT rate 
from the sales tax window, click on Add.  Then, enter the state, city, and the 
sales tax as a percent.  For example, 6.5% sales tax would be entered as 
6.5.  We recommend that you also create a 0% tax line for those sales that 
are tax exempt.  Exit the entry window by clicking on the X at the upper right.   
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You should then select the default sales tax to be used on an invoice from 
the list that you created.  Simply click on the down arrow and highlight your 
choice.  The default sales tax can be overridden at the time of invoicing.  
Select either American or European Tax Method.  The American method 
multiplies the invoice total by tax rate to get the tax amount.  With the 
European method, the tax is already built into the price of each item and 
does not need to be added at the end of the invoice.  Finally, select either 
Invoice Level or Line Item Level.  Invoice level calculates the tax on the total 
of the invoice, where Line Item Level calculates the tax for each line item and 
then totals the individual tax amounts. 
 

•  Quantity Based Pricing.  Portrait One Manager allows you to set up your 
pricing structure to offer quantity discounts.  Select from the options shown 
here to determine how Portrait One Manager will calculate quantity 
discounts. If you select the first option, Portrait One Manager will use the 
quantity for this line and then look at the pricing levels tab in the Item 
Maintenance to determine if any discounts should be applied.  If you select 
the second option, Portrait One Manager will total all the lines in this invoice 
that match this item number and use that quantity to calculate any discounts, 
again based on the information on the pricing levels tab of the Item 
Maintenance.   If you do not wish to use quantity discounts, select the last 
option. 

 
•  Client Invoicing Price List.  Most of your Portrait One Manager invoices will 

be connected to a session, but on occasion you will create an invoice that is 
not related to a session.  This is called a client invoice.  You can set the price 
list that Portrait One Manager will use for that type of invoice here.  Use the 
down arrow to select which of your price lists will be used for this purpose.  
This option can be changed at any time, but cannot be overridden at the time 
of invoicing. 

 
 
7. Miscellaneous Tab.  Listed below are the options available on this tab. 
 



 Page 127 

 
Company Preferences Screen – Miscellaneous Tab 

 
•  Product Lines.  Product lines are selected when setting up sales items 

in the Item Maintenance Screen.  Product lines are used in sales reports 
to help categorize your sales figures.  You should set up your product 
lines into whatever groups you want to see on your sales reports. 
 

•  Film Type Maintenance.   If your studio uses film, enter all the types 
you use here.  If you want to track cost of sales, enter a cost for that film 
type.  The types you enter here are used in the generating of proof 
orders. 

 

 
 

•  Reorder Reason Codes.  These codes are used in the generation of 
production re-orders.  Add, Delete, or Modify as needed.  If the reorder 
code is not chargeable, be sure to check that box. 

 
•  Production, Proof, and Session Status Maintenance.  See the 

chapter on ‘Working with Post Session Production Tracking’ for more 
information on these sections. 
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•  When Assigning Negative Numbers.  Select how you will assign 
negative numbers – sequentially, or using the roll number and frame 
number.  These options affect how your production orders are generated. 

 
•  Next Number to Assign.  You may control the next client number, 

invoice number, and session number that Portrait One Manager assigns.  
Numbers are then generated sequentially.  Alpha characters are not 
allowed.  You may change this number at any time, however, be careful 
not to set the number backward so that duplicate numbers will end up 
being assigned to multiple records. 

 
•  Credit Card Processing.  If you are using the PC Authorize software that 

is compatible with Portrait One Manager, enter the server name and 
server port here.  If you are not using PC Authorize, leave this blank. 

 
 

8. Sessions and Appointments Tab.  Define the default values for your sessions 
and appointments under this tab. 

 

 
Company Preferences Screen – Sessions and Appointments Tab 
 

•  Custom Field Labels.  Portrait One Manager allows you to define up to 10 
custom fields in the session information screen.  You may label those fields 
here.  The actual custom fields are located on the session information 
screen, under the Custom tab. 

 
•  Session Types.  One of the best features of Portrait One Manager is that 

you may define any number of session types.  Session types are then linked 
to a price list.  Session types are defined here, and may also be defined 
under Price List Maintenance.  See the section of this manual on Working 
with Sessions for more information on how to set session types.  Each 
session type may have a default length and color. 
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•  Appointment Types.  Like session types, appointment types can have a 

default length and a unique color on the calendar.  Enter all the types of 
appointments you’ll want to schedule on your calendar – from consultations 
to proof reviews to golf dates! 

 
•  Promotions.  Promotions are used on the session information screen to help 

you track revenue by type of promotion.  Enter all your promotion types here, 
then select the appropriate promotion when scheduling a session. 

 
•  High Schools.  Create and maintain a list of all the high schools you work 

with as well as their address and yearbook information.  Then, select the 
proper high school when setting up a senior session. 

 

 



 Page 130 

•  Inside Locations.  Create and maintain a list of all the locations within your 
studio that you’d like to track on the calendar.  Portrait One Manager makes 
sure you never double book a location.  Include the address if you’d like it to 
appear on a session confirmation notice for the client.  The default location 
you choose for a session can be overridden at the time of booking if needed. 

 
•  Outside Location Maintenance.  Just as you maintain inside locations, you 

can also create a list of commonly used outside locations.  Then simply 
select the location from the drop down list when scheduling a session outside 
the studio. 

 
 

9. Phone Calls Tab.  Enter information related to the types of phone calls your 
studio makes, as well as the phone numbers you want to obtain for each client. 

 

 
Company Preferences Screen – Phone Calls Tab 

 
•  Phone Call Types.  Click on this button to create a list of all the types of 

phone calls your studio makes.  Add, Delete, or Modify these types as 
needed.  Then, select them from the drop down menu when creating phone 
call records. 

 
•  Phone Labels.  You may create any number of phone call labels by clicking 

on this button.  Then, you may select which of these labels will be the default 
for the phone number fields in a client record.  Setting or changing the 
defaults affects clients created AFTER the change is made.  Labels in 
existing client records are not affected.   

 
•  Default Area Code.  Enter the default area code by clicking in the proper 

field and then typing it in.  This area code will automatically be included when 
you enter client phone numbers. This is usually the area code your company 
resides in, or the area you will call the most. 

 
10. Reports Tab.  On the reports tab you can set all your printing options for Portrait 

One Manager, by report type. 
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Company Preferences Screen – Reports Tab 

 
•  Printer.  Choose Default Printer to use the printer you have selected in 

Windows.  Choose Prompt for Printer if you would like to select the printer or 
number of copies each time you print a report.   All printers you have defined 
in your Windows setup will be available for selection here. 

 
Selecting Prompt for Printer for a Single Mailing Label not only gives you the 
option of choosing the printer, it will allow you to define the starting label 
position on a sheet of laser labels so there’s no waste.   
 

 
•  Paper Bin.  You may choose the Default Paper Bin set up in Windows, or one of 

the other options here.  Default Paper Bin works in most cases.  If you are using 
a dot matrix printer, select Tractor Feed from the menu.  You may also select 
Manual Feed.   

 
•  Number of Copies.  Choose the number of copies that you want to print each 

time you generate a report.  Remember, choose Prompt for Printer as your 
printer option if you want to specify a number of copies each time you print. 
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•  Global or Station Settings.  All workstations that use Global Print Settings use 
the same setting.  Workstations using Stations Settings have settings strictly for 
that workstations only.   

 
11. Reports 2 Tab.  On the reports tab you can set more printing options for Portrait One 

Manager. 
 

•  Report Header.  Whatever you enter into the Report Header Section will appear 
on the top of each report under your company name.   

 
•  Profit Analysis Report.  For the Profit Analysis Report, Portrait One Manager 

gives you several options to determine how it should calculate the total cost of 
each session.  First, should it include any film costs, based on the kind and 
number of rolls of film you enter in the Proof Order?  Second, should it include 
any proofing costs, determined by the invoice total amount you enter on each 
Proof Order?  Thirdly, should it include Product Costs? If so, you have two 
options to calculate the product costs.  Using Item Maintenance Costs will pull 
the cost for each item on an invoice from the Costs tab of the Item Maintenance 
screen.  Using Production Order Costs will pull the cost from the Invoice Total 
field that you fill in on each Production Order.  The first option requires more up 
front setup but is then calculated manually.  The second option requires you to 
input the figure manually that you receive from your vendors’ invoices, but should 
be more accurate than the first method. 

 

 
Company Preferences Screen – Reports 2 Tab 

 
12. Digital Tab.  The digital tab is used to setup digital imaging features in Portrait One 

Manager.  See the section ‘Working with Digital Imaging’ for further information on 
this tab. 
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Company Preferences Screen – Digital Tab 

 
13. Slide Show Tab.  The Slide Show Tab allows you to set the defaults for your next 

slide show.  See the ‘Working With Digital Imaging’ section for further information on 
this tab. 

 

 
Company Preferences Screen – Slide Show Tab 

 
14. System Tab.  These settings should only be changed under the direction of a 

Technical Support Specialist.  Make sure you restart Portrait One Manager after 
changing any of these settings. 
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Company Preferences Screen – System Tab 

 
•  Keep Database Persistence.  Setting this option to yes forces Portrait One 

Manager to keep a permanent connection to the Database as long as Portrait 
One Manager is Open. Setting this option to No, forces Portrait One Manager to 
disconnect from the database whenever possible.  This option will slow 
performance, but may improve reliability.   

 
•  Browse Refresh.  This setting determines how often Portrait One Manager 

should refresh the Browse Screens so changes that other machines make to 
data records will be automatically reflected on the other computers.   

 
•  Database Cache.  This setting determines how long a database connection 

should be cached in memory before it is released.  Once it is released, a new 
one will have to be created if it is needed.   

 
•  Cash Drawer.  If an APG cash drawer is connected to this workstation, set this 

setting to yes.   
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User Preferences 
 

The User Preferences screen is used to set the defaults of how Portrait One Manager 
looks and works for the individual user. 

 

 
The User Preferences Screen – Options Tab 

 
•  Options Tab. 
 

1. Calendar.  The calendar section of the options tab is where you set the time 
increments to be displayed in the calendar browse screen.  If you were to 
choose 30 Minutes you would only have two lines per hour representing the 
Hour and half-hour on the calendar browse screen.  The calendar browse 
screen is defaulted to 15-minute intervals. 

 
2. Wizard.  The wizard section allows you to choose which, if any, of the 

wizards you want to use.  All wizards are active by default.  To make a 
wizard inactive simply click on the check box next to it. 

 



 Page 136 

 
The User Preferences Screen – Palm Hot Sync Tab 

 
•  Palm Hot Sync Tab. 
 

To synchronize this users schedule and to-dos with a Palm handheld device, 
click the first box.  Enter the User Name exactly as it appears in the Hot Sync 
program.  Populate the handheld during the next hot sync will force all Portrait 
One Manager calendar events and to-dos to be copied from Portrait One 
Manager to the handheld.  Populate Portrait One Manager during the next hot 
sync will force all existing calendar events and to-dos to be copied from the 
handheld to Portrait One Manager.  If you don’t want any new handheld 
appointments to be added to Portrait One Manager, then uncheck the second to 
last checkbox.  If you don’t want any new handheld to-dos to be added to Portrait 
One Manager, then uncheck the last checkbox.  
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Add & Remove Users 
 

 
 

1. From the Menu Bar, choose Maintenance, Users & Security.  This will bring up the 
Add/Remove Users Dialog box. 

 
2. To add a user, click on the Add button.  Type the new user’s initials and name into 

the appropriate fields.  Type them as you want them to appear.  Select one or more 
check boxes to define the type of user.  Enter a Sort Order to determine the order this 
person should appear on any user lists. Click O.K. 

 
3. To remove a user, first highlight the user you want to remove, then click the Remove 

button.  A message will appear asking if you are sure you want to remove the user.  If 
you’re sure, click “Yes”.  If you aren’t sure, click “No”. 

 
4. To copy a user, first highlight the user you want to copy, then click the copy button. 

Type the new user’s initials and name into the appropriate fields.  Type them as you 
want them to appear.  Click O.K.  This option is helpful if you want to create a new 
user that has the same security clearances as an existing user. 

 
5. To clear or reset a user password, first highlight the user and then click the Clear 

Password button.  A message will appear asking if you want to clear the password for 
the user.  If you do, click the Yes button.  If you don’t, click the No button.  
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Modify Security Levels 
 

The User Permissions Screen is where you will set the different security levels for 
individual or multiple users of Portrait One Manager. 

 

 
   The User Permissions Screen. 
 

There are three primary sections to the User Preferences screen.  They are; the User 
List, the Security Feature List and the Security Options section. 
 

•  User List.  The user list is where you will choose the user or users whose 
security you want to modify. 

 
•  Feature List.  The feature list is where you choose the options within Portrait 

One Manager for which you want to set the user’s security. 
 

1. Invoices & Payments.  Invoices & Payments controls the user’s access 
to create, modify or delete invoices and payments. 
 

2. Lists.  The Lists option controls the user’s ability to modify the pull down 
menus. 
 

3. Preferences.  The preferences option controls the access to company 
wide preferences. 
 

4. Users & Security.  The users & security option controls the access to 
adding new users and setting user permission levels. 
 

5. Reports.  The reports option controls access to printing statistical reports. 
 

6. Word Merges.  The word merges options controls access to creating and 
printing word merge documents. 
 

7. Utilities.  The Utilities option controls the access to the utilities menu. 
 
•  Security Options.  The security options section is where you will set the 

access level of the program list option for the users. 
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  To modify security for a user or multiple users, follow the steps below. 

 
1. Highlight the user or users you want to modify by clicking on their 

name(s).  You can set the security for multiple users by highlighting more 
than one user at a time.  To highlight multiple users, click on a user and 
hold the control key and click on each of the rest of the desired users.  
To highlight a range of users, click on a user and then hold the shift key 
and click on the last users you want in the range.  All of the users in 
between will also be highlighted. 

 
2. In the feature list, click on the option on which you want to set the 

security. 
 

3. In the security options section select No Access if you don’t want the 
user to be able to edit the option in any way.  Select Full Access if you 
want the user to have no restrictions on the use of the option. 

 
4. Repeat these steps until all security settings have been made. 
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Maintenance List Menu 
 
All of the items listed in the Maintenance List Menu can be found in the Company 
Preferences, with the exception of Price List Maintenance.  See the Company 
Preferences section earlier in this chapter for more information on these items. 

. 
 

Price List Maintenance 
 

In order to properly invoice clients for session fees, print orders, packages or any other 
item your studio sells, you must create price lists in price list maintenance.   Each price 
list is linked to a session type that you define.  You may have as many session types and 
price lists as you choose.  For example, you may have several different types of senior 
sessions – Senior Yearbook, Senior Sports, Senior Other.  All of these sessions might be 
linked to the same price list – the senior price list.  On that price list would be all the 
session fees and item prices for products relating to any senior session.   When an 
invoice is generated from a session, only the items on the price list assigned to that 
session are available for invoicing.  More information about creating session types is 
found in the Company Preferences section of this manual. 

 

 Bugged About Something?? 
 
Why use multiple Price Lists?   
 
You should choose to use multiple price lists only if you charge different prices 
for the same product for different types of sessions.  For example, if you charge 
one price for an 8X10 for a family session and a different price for the same 8X10 
for a wedding, then you would want to use multiple price lists. 
 

 

 Bugged About Something?? 
 
Why use multiple Session Types? 
 
You should choose to use multiple session types if you would like to track 
session trend information on reports.  For example, if you would like to know how 
many Premier Weddings you have done this year, and how many you have done 
compared to last year, then you will want to use session types to track this 
information.  Another benefit of using multiple session types is that you can 
define a default length for each type of session and a different color to display the 
session on the calendar screen.  You must use multiple session types if you want 
to use multiple price lists. 
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The Price List Maintenance screens are accessed from the main Portrait One Manager 
Menu under Maintenance, List Maintenance.  There are two main parts to Price List 
Maintenance: the Price List screen and the Item Maintenance detail screen. 
 

Price Lists  
 

All the products your studio sells will be entered into price lists through this screen.  You 
will then link every type of session your studio does to the proper price list. When you 
create a new price list, Portrait One Manager automatically creates item categories in that 
price list.  The categories are Session Fees, Portraits, Packages, Composites, and 
Miscellaneous.  In the example below, there are four price lists:  Portrait, Wedding, 
Senior, and Generic. 

 
  

 
   The Price List Screen 
 
 
The three main sections of the Price List screen are the Menu Bar, Tool Bar and the 
Browse Screen. 

 
•  Menu Bar.  Options available include File, Edit, Maintenance, and Help.  

 
1. File.  From this menu you can create a new price list, item group, or item 

as well as delete any existing price list, item group, or item.  These 
options are also represented on the tool bar as icons. 

 
2. Edit.   The edit menu allows you to edit any price list name, item group 

name, or item detail simply by highlighting and selecting Edit from the 
edit menu.  You may also copy any price list and all its items.  This 
option is helpful when creating price lists that have a great deal of 
similarity.  You may copy an entire price list and then simply rename and 
edit it as needed using the edit option.   

 
 

3. Maintenance.  Here you can create and maintain lists of: 
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a. Session Types: To assist in organizing all the types of sessions you 
do, you may create your own session types.  For example, you might 
have different types of wedding coverage: Standard, Royal, Deluxe, 
etc.  Each wedding coverage could be created as a session type.  
You may have as many session types as you find helpful.  
Remember, each session type is linked to a price list for invoicing 
purposes, and only items on the price list you’ve selected will be 
available for invoicing.  Note:  Session types can also be maintained 
under Maintenance ⇒  Preferences⇒  Company Preferences 
⇒ Sessions and Appointments.   See the section titled "Features of 
the Company Preferences Screen" for additional information.                                          

b. Product Lines: Use product lines to categorize your products for 
reporting purposes only.  For example, if you wish to see your sales 
for the year, but don’t want to see too much detail, use product lines 
to group your sales information.  Some examples might include Color 
Prints, Session Fees, Frames and Folios, and Black and White 
Prints.  Product Lines are optional. 

c. Options:  As you create an item, you may add optional upgrades to 
the base price of the item.  For example, you might add a location 
fee to the basic price of a session. Or, you might add a clothing 
change fee to the cost of a senior session.  While you may create 
any number of options for an item, you may only select ONE of those 
options when invoicing.  

d. Enhancements:  Like options, enhancements are added to the base 
price of an item.  For example, you may add a basic retouch fee to 
the price of an item, or colorization to a black and white portrait.  You 
may create any number of enhancements for an item, but you may 
select only ONE enhancement when invoicing. 

e. Composite Layouts: You may enter the composite layouts available 
from your lab or labs here and then, during invoicing, select them 
from a drop down menu to make invoicing quicker.  

 
•  Tool Bar.  The tool bar has icons to add a new price list, group, or item; edit 

an item or group and delete an item, group or price list. 
 

1. New Price List.  Use this icon to add a new price list.  Portrait One 
Manager will automatically add the item categories of Session Fees, 
Portraits, Packages, Composites, and Miscellaneous as part of the newly 
created price list. 

 
2. New Group.  Use this icon to add an item group to one of the categories 

that Portrait One Manager has created for you, such as color prints. 
 
3. New Item.  Use this icon to add an item to an existing item group. It is 

here that you actually enter pricing information about the item.  This will 
be examined more completely in the next section. 

 
4. Edit Item.  Click on any existing item to edit its associated pricing 

information. Double-clicking on the item will also allow you to edit the 
item. 

 
5. Delete Item, Item Group, or Price List.  Use this icon to delete an 

existing item group or session type.  First click on the item or group you 
want to delete and then click on the Delete icon.  All information 
associated with the selected item will be deleted.  For example, deleting 
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a group causes all associated items in that group to be deleted.  Deleting 
a price list causes all associated groups and items to be deleted.   

 
Expanded View of the Price List Browse Screen 

 
•  Detail Screen.  The Detail Screen shows all of the different Price Lists, 

Categories, Groups, and Items that you have set up in Portrait One Manager.  
Structuring Price Lists and Groups carefully allows you to have all your items 
grouped in a way that is easy to understand – keeping all items of one type 
together. 

 
a. Price Lists and Categories.  You create price lists based on the main 

categories of items that your studio sells.  In the screen above, Portrait, 
Wedding, Senior, and Generic are all user defined price lists.  The user 
can create and name any number of price lists.  Each price list is linked 
to a user-defined session type. 

 
Each price list is further broken down into five categories: Session Fees, 
Portraits, Packages, Composites and Miscellaneous.  These categories 
are always assigned by Portrait One Manager to each price list you 
create and cannot be modified.  However, you do not have to have items 
in each category. 

 
b. Item Groups.   A group is simply a cluster of several related items. In the 

example above,  “b/w 5x7 prints” and “b/w 8x10 prints” are two of the 
groups for the Portrait category on the Portrait Price List.  You must 
place items into groups within a price list.   

 
To add a group, select the item category to which you desire to add the 
group by clicking on the plus sign in front of the category.  In the example 
above, the group “b/w 5x7 prints” was added by first clicking on the plus 
sign in front of the Portrait price list, then clicking on the plus sign in front 
of the category “Portraits” and then clicking on the Add Group Icon. 

 
c. Items.  This is where you actually enter pricing for each item. First click 

on the group to which you want to add the item and then click on the 
New Item Icon.  In the example above,  “bw57fp” and  “bw57ftp” are 
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items that are under the group “b/w 5x7 prints”.  See the next section, 
Individual Item Maintenance, for more detailed information of items. 

Individual Item Maintenance 
 
 

 Here’s a Flash for You! 
 
Hey, don’t be alarmed by the amount of information required on these tabs.  Only 
four categories actually must be completed: 
♦   Item Identifier  
♦   Description 
♦   Non-taxable 
♦   Base Price 
 
 

 
The Item Maintenance Screen holds the details of the individual retail items sold by your 
company.  Many of the tabs and fields in Item Maintenance are optional; however, the 
more you use them, the greater your flexibility in invoicing. 

 

 
 The Item Maintenance Screen 
 

1. Menu Bar.  The menu choices are File (Save, Save and Close, Delete, and Exit) and 
Edit (Cut, Copy, and Paste). 

 
2. Tool Bar.  The icons are shortcuts to all of the various menu choices.  From left to 

right the icons are; Save, Save and Close, Delete, Copy, Cut and Paste.  If you place 
your mouse cursor over the icon and hold it, a text box will pop up (called a tool tip) 
with the name of the action that is tied to the icon.  Simply click on the corresponding 
icon for the desired action you want to perform. 

 
3. Detail Section: General Tab.  This is where basic item information is located and 

entered. 
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a. Item Identifier.  The user assigns the Item Identifier.  Item Identifiers can 
be any combination of letters and numbers up to 12 digits in length.  The 
Item Identifier must be unique within this price list, but may be used 
again in other Price Lists.  (Optional, but recommended) 

 
b. Description.  Description tells you what the item is.  This description will 

appear on the customer invoice. (Required) 
 

c. Lab Description.  Select the proper lab description from the options 
available by clicking on the down arrow.  The drop down list is controlled 
by Portrait One Manager and is not modifiable.  However, you may type 
in a description that is not shown on the available list. (Optional) 
 

d. Crop Ratio.  Enter the crop ratio commonly used for this item. 
(Optional) 
 

e. Preferred Vendor.  Select the vendor from whom you most often 
purchase this product.  The vendor list is maintained by you on the main 
menu under Maintenance, Preferences, Vendor Maintenance.  
(Optional) 

 
f. Product Line.  Product Lines are used to group items that are of a 

similar type.  Sales reports are grouped by Product Line, so it’s extremely 
important to create product lines that will group sales items in the way 
you want them to be reported.  Product lines are created in Maintenance, 
Preferences, Company Preferences, under the Miscellaneous tab. 
(Optional) 

 
g. GL Sales Account.  You may select the specific GL account to which 

you want sales of each item to be posted.  If this is left blank, sales will 
post to the default sales account listed in Company Preferences under 
General Sales.  If an accounting link is chosen, data will export to the 
sales account number listed here; otherwise, the account number merely 
prints on all posting reports. (Optional) 

 
h. Non-Taxable Check Box.  Check this box if the item is always non-

taxable. (Optional) 
 

4. Detail Section: Pricing Levels Tab.  This tab allows you to define quantity discounts 
for the item.  For example, if the price of a print drops when more than 5 are 
purchased, that information would be entered here, eliminating the need to always 
watch for quantity discounts when invoicing.  
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5. Detail Section:  Pricing Tab.  Pricing information, the amount you charge your 
customers, for all pricing levels is entered on this tab.  The Base Price for the item is 
entered first, followed by any options or enhancements that are available for this 
item.  The lower half of this screen displays the pricing structure for the item as you 
have defined it. 

 
To bring any item into the data entry area, just click on its description on the left side 
of the screen.  Once a line is in the data entry area, it can be modified or removed.  
Enter a price for each level that you have created under the Pricing Levels tab.  If you 
have only one pricing level, you only need to enter a price in the box labeled "Level 
1". 
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 Bugged About Something?? 
 
How is pricing calculated when using options and enhancements?   
 
At the time of invoicing, you are allowed to choose one predefined option and 
one predefined enhancement.  The first step is to determine the quantity based 
pricing level.  For example, if the user is purchasing 10 5X7’s, and a pricing level 
is established for quantities 10 through 20, then all pricing would come from that 
pricing level.  Next, the price for the option, for that price level, would be added to 
the price for the enhancement, for that price level, which would be added to the 
base price for the item, again for that price level.  For example, an enhancement 
price of $3.50 would be added to an options price of $1.50 would be added to the 
base price of $20.00, which would equal the new item price of $25.00.  Finally, 
this new item price of $25 would be multiplied by the quantity of 10 to equal the 
extended price of $250. 
 

 
a. Base Price.  To select the base price, click on the words "Base Price" in 

the middle left of the screen.  This will activate the data entry area and 
allow you to enter the price for the item by level.  If there is no level 
pricing for the item, you need only enter a price in the Level 1 window.  
When done, click on Save Line. 
 

b. Add Option.  Options are additional items that may be purchased at the 
time the item is invoiced.  Examples may include framing, mounting, or 
sprays.  Options are user maintained and are added on the Price List 
Screen under the menu option Maintenance, Options.  Enter the price of 
the option for each pricing level.  If there is only one pricing level, you 
only need to put the price in the first window.  Click "Save Line" to record 
your prices.  
 

c. Add Enhancement.  Enhancements such as retouching can be added 
to the base price of a print.  Enhancements are also user maintained 
from the Price List Screen.  Clicking on this button allows you to select 
the desired option in the Description window. 
 

d. Description.  Clicking the down arrow will allow you to select the option 
or enhancement description of all the options or enhancements that you 
have defined.  You must select a description and it must be from the pre-
created list.   
 

e. Sort Order.   If you'd like your options or enhancements to display on the 
screen in a certain order, assign a sequential number or letter 
representing the placement of the item in this box. 
 

f. Price Boxes by Level.  As you enter options and enhancements 
available for this item, place the appropriate pricing by level in each box.  
Then click on Save Line (or Remove Line if you do not wish to save your 
entries). 
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6. Detail Section: Cost Tab.  Information about the actual cost of an item, the amount 
you pay your vendor for this item, is entered on this screen.  It looks and functions 
just like the Pricing Tab.  However, the amounts listed here are not the retail pricing, 
but the item’s actual cost.  You can also enter the actual costs of Options or 
Enhancements.  Information entered here is used in profit analysis reports.  This tab 
is not required unless you plan to use accounting profit reports. 

  
7. Detail Section: Packages Tab.  This tab is only available if you are creating an item 

under the packages category of your price list.  To create a package, each item in the 
package must already be on your price list.  Simply select each item for the package 
from the drop down list.  Choose the quantity of that item for this package.  Any 
options or enhancements that you created for each item are also available in the 
package.  You may select 1 option and 1 enhancement for each item.  If you want the 
items in the package to appear in a specific order, enter a sequential number or letter 
in the "Sort Order" field.  When you invoice for this package, all the components of 
the package will print on the invoice, in the sort order you specify. 

 
 

 
 
To edit any item in the package, double-click on that item.  Make that change in the 
data entry window and click Save, or click Remove Line if you wish to delete the 
package item.  You must save each individual line in the package as well as saving 
the entire item package by using the Save icon. 
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Importing Client Records 
 

Portrait One Manager allows you to import client records from other programs.  The 
types of files that Portrait One Manager recognizes are; ASCII comma delimited, and 
Excel® spreadsheets.  To import client records follow the steps below. 
 

Importing Client Records Using a New Data Source 
 
1. From the Utilities menu, choose Import Clients. 

 
2. The import wizard will launch.  Accept the default “Import from a new data 

source” and then click Next. 
 

3. Choose the type of file you will be importing and then click Next. 
 

4. Locate the file and click the Open button. 
 

5. Find the appropriate field in the right hand window (they start with “fld” which is a 
programmer’s naming convention) and drag it to the corresponding column in the 
left-hand window. 

 
6. When you are through assigning all of the fields, click Next. 

 
7. Click ‘Automatically Assign Client Number’ if you are not importing a pre-

assigned client number for each client. 
 

8. Click ‘Assign to Client Group’ if you want these clients to be placed in a new or 
existing client group.  Click Next. 

 

 Here’s a Flash for You! 
 
It is recommended that you place your new clients in a new group called 
something like ‘Import Sept 1’.  That way, after the import is complete and if you 
discover something went wrong, like you forgot to import a field, then you can 
delete the group of clients you just imported using the ‘Delete a Group of Clients’ 
feature and then re-import them. 
 

 
 

9. If this is an import that will be done again in the future, you can save it as a 
template.  This will save you from having to assign the fields again.  To save it as 
a template, click the Save Template button.  Type in the name you want to 
assign to this template and click the O.K. button. 

 
10. Click the Finish button. 

 

Importing Client Records Using an Existing 
Template 
 

1. From the Utilities menu, choose Import Clients. 
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2. The import wizard will launch. Choose the option “Use an existing import 
template” and then click Next. 

 
3. Choose the template from the list and click O.K. 
 
4. Locate the file and click the Open button. 
 
5. As you have already saved this as a template, you can just click the Finish 

button.  (If you want to save it as a template again you can, but you must give it a 
unique name.) 

 
 

Export Clients 
 

Portrait One Manager has the ability to export a group of clients to an ASCII text file 
(comma-delimited). 
 
1. From the Utilities menu, choose Export Clients to launch the Export Wizard. 
 
2. Choose the filter or group of clients that you want to export. Click Next. 
 
3. Enter the path and file name of the text file that should be created during the 

export. Click Next. 
 
4. Click Finish to begin the export. 

 
 

Import Price List 
 

Portrait One Manager has the ability to import a new price list or import modifications 
to an existing price list.  For further details, visit www.StudioPlusSoftware.com for 
technical specifications or call your technical support department. 
 

 

Backing Up Data Files 
 

Portrait One Manager can make a backup copy of your database for you.  To make a 
backup of your database files, follow the steps below. 
 
1. From the Utilities menu, choose Backup Data Files. 
 
2. You will be prompted for the location to place the backup.  Unless you are 

placing the backed up files onto a separate drive, like a zip drive, you should 
accept the default location.  Click Backup.  It is highly recommended that you 
copy these backup files to other media such as a tape drive, zip disk, or CD.  You 
risk losing both sets of files by keeping them on the same hard drive. 

 
3. Portrait One Manager will create a zipped file that contains the data files.  If you 

ever need to restore a backed up copy of the data files, use the Database Utility 
found under the Start Menu ⇒  Program Files ⇒  Portrait One Manager. 
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    ATTENTION!   
 
Make sure that you backup your data files DAILY, by either using the Portrait 
One Manager backup utility or by using your own backup software!  If your data 
files become corrupted beyond repair or if your hard drive crashes, you will lose 
all of your data, unless you have a current backup.    
 

 
 
Compacting Data Files 
 

 Here’s a Flash for You! 
 
It is highly recommended that you Compact your data files periodically, at least 
weekly.  But why?  Portrait One Manager stores its data in Microsoft Access Data 
Tables.  Access builds its own internal temporary files.  Running a compact 
rebuilds the data files and removes any temporary files.  Not only will the data 
files be reduced in size, but performance can increase, and data corruption can 
be prevented. 
 

 
To Compact the Portrait One Manager database, follow the steps below. 
 
1. From the Utilities menu, choose Compact Data Files. 
 
2. A message will appear indicating that Portrait One Manager must close and all 

other users (only if you are compacting the network installation) must exit the 
program. 

 
3. Click the O.K. button.  Portrait One Manager will close, the compact will 

complete, then Portrait One Manager will reload.  
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Form Letter Builder 
 

Form Letter Builder allows you to create form letters to be used in mass mailings or 
broadcast emails.  
 

 Pathways to Success  
 
How do you currently market to your customers?  Do you know what your 
customers’ interests are?  Do you tailor and personalize your marketing to each 
client?  Using Portrait One Manager to its fullest potential can greatly help you 
increase your studio’s revenue.  Give some thought to how you can utilize 
Portrait One Manager to more effectively market your products and services to 
your client base. 
 

 

Adding a Form Letter 
 

1. From the Tools menu, choose Form Letter Builder. 
 
2. Click on the Add button. 

 
3. Enter a description of the form letter you are about to create. 

 
4. Choose the Filter (if any) from the drop down box. Choose the user (it will 

default to the current user if left blank) from the drop down box.  Click OK. 
 

5. If you are planning to e-mail this letter, then select File ⇒  Letter Properties to 
enter the Subject Line for the e-mail. 

 
6. Next, create your letter.  Use any formatting tools on the tool bar to 

customize the letter.  If you want the letter to contain personalized 
information from the client’s records, click the Insert Field button.  Select the 
field from the database you want inserted in the letter and click OK.  To insert 
the current date, select Date(Now) from the list. 

 
7. After you’re done building the form letter, click File ⇒  Save.  Click File ⇒  

Quit to close the Form Letter Builder. 
 

Deleting a Form Letter 
 

1. From the Tools menu, choose Form Letter Builder. 
 
2. Click on the form letter you want to delete. 

 
3. Click on the Delete button. 

 

Modifying a Form Letter 
 

1. From the Tools menu, choose Form Letter Builder. 
 
2. Click on the form letter you want to modify. 
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3. Click on the Modify button. 
 
4. Make your modifications to the form letter. 
 
5. Save your form letter. 
 

Copying a Form Letter 
 

1. From the Tools menu, choose Form Letter Builder. 
 
2. Click on the form letter you want to copy. 

 
3. Click on the Copy button. 

 

Printing a Form Letter 
 

1. From the Tools menu, choose Form Letter Builder. 
 
2. Click on the form letter you want to print. 

 
3. Click on the Print button. 

 
4. Select the filter you want to print the form letter for. 

 

 Here’s a Flash for You! 
 
Form letters can also be printed for a single client from either a client, session, or 
invoice information screen File Menu. 
 

 
 

E-mailing a Form Letter 
 

1. From the Tools menu, choose Form Letter Builder. 
 
2. Click on the form letter you want to e-mail. 

 
3. Click on the E-mail button. 

 
4. Select the filter you want to e-mail the form letter to. 

 

 Here’s a Flash for You! 
 
You must perform any e-mailing on a PC that already has a MAPI-compliant e-
mail program installed and operational. 
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Filter Builder 
 

 Bugged About Something?? 
 
What is a Filter? 
 
A filter is a method to select a group of records.  A filter can be used to determine 
which group of records should be shown on the report.  A group of call records 
can be created for all the clients in a filter. An email can be sent to all the clients 
in a filter.  A Sales Analysis Report can show total sales figures for all invoices in 
a filter.   
 

 
When you create a filter you tell Portrait One Manager which field or fields you want 
to use to search for records containing certain information.  Follow these steps to 
create a new Filter. 
 

 
 

Adding a New Filter 
 

1. From the Tools menu, choose Filter Builder. 
 
2. Click the Add button.  
 
3. Type in a description of the new filter. 

 
4. Select the type of filter you want to create.  
 
5. Choose the first field you want to use to perform your criteria search from 

the drop down list. 
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6. Choose the operator from the drop down menu. 
 
7. Fill in the value you will be filtering on.  If you want to search for all blank 

values don’t enter anything into the value field.  If you want to conduct a 
search based on the current date, type Date() in the value field, or type 
Date() + 7 representing the current date plus 7 days. 

 

 Here’s a Flash for You! 
 
Here are some examples of various criteria expressions you may create: 
 
Client–City = Chicago  (Includes all clients in Chicago) 
Client–Last Name Like M*  (Includes all clients with last names starting with 

M) 
Client–Zip Code >= 60000  (Includes all clients whose zip code is greater 

than or equal to 60000) 
Session–Date < Date() + 1  (Includes all sessions before tomorrow’s date) 
Session–Date =    (Includes all sessions with no session date) 
Invoice–Delivered Date <>    (Includes all invoices where the delivered date is 

not blank) 
Invoice–Invoice Total < 100  (Includes all invoices under $100) 
 

 
 
8. Click the Add button and repeat steps 5-8 for each search criteria you 

want included. 
 
9. To verify how many records are in your filter, click the update count 

button. 
 
10. To specify how your group of records is sorted, click the Sorting tab.  

You can select one or more fields to sort by and you can specify whether 
you want the records sorted in ascending or descending order. 

 
11. Click OK to save your filter. 

 
 

Deleting an Existing Filter 
 

1. From the Tools menu, choose Filter Builder. 
 

2. Click on the filter you want to delete. 
 

3. Click the Delete button. 
 
 

Modifying an Existing Filter 
 

1. From the Tools menu, choose Filter Builder. 
 

2. Click on the filter you want to modify. 
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3. Click on the Modify button.  Make changes as needed. 
 

 
Copying an Existing Filter 

 
Copying an existing filter is a great way to take an existing filter, copying it so 
that it can be modified slightly to make a new one, without having to create a 
new one. 

 
1. From the Tools menu, choose Filter Builder. 

 
2. Click on the filter you want to copy. 

 
3. Click on the Copy button. 

 
4. Edit the copy to change the criteria or sort information.  

 
 

Wizard Builder 
 

Portrait One Manager is well known for its easy-to-use wizards to quickly and 
accurately enter data into the program.  The Wizard Builder allows you customize 
these wizards to better suit the way your studio operates.  Click Tools ⇒  Wizard 
Builder.  Select the drop-down menu at the top of the screen to select the Wizard that 
you want to modify.  Click the plus signs next to the pages that you want to open up 
to see more pages.  For each page in the wizard you can modify the Page Header 
that appears at the top of each page.  You can also choose to Hide certain pages 
that may not pertain to your studio.  Certain pages are required by the Wizard and 
cannot be hidden. Close the form by clicking the X in the upper right corner. 
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Archived Image Finder 
 

If you use Portrait One Manager to archive images to CD’s, then you can use the 
Archived Image Finder to search through all the archived files to find out which CD 
the desired images are on.  Click Tools ⇒  Archived Image Finder. Select your search 
criteria from the list including Archive CD Number, Archive Date, Client Name, File 
Name, Last Modification, Session Date, Session Number, and Studio Number. Enter 
the data to search for and press Enter. 

 

 
 
 

Add Clients to a Group 
 
Client Groups are a great way to categorize or group your clients for various 
purposes, such as mailing lists, phone calls, or reports.  Use this feature to quickly 
add a group of clients, for a filter or another group, to the desired group.  Click Tools 
⇒  Add Clients to a Group.  Follow the steps of the wizard to either add the clients to 
a new group or an existing group, and then to select the client group or filter of clients 
that should be added.  Click the Finish button to perform the operation. 

 

Remove Clients From a Group 
 
Client Groups are a great way to categorize or group your clients for various 
purposes, such as mailing lists, phone calls, or reports.  Use this feature to quickly 
remove a group of clients from the desired group.  Click Tools ⇒  Remove Clients 
from a Group.  Follow the steps of the wizard to select the group the clients should be 
removed from, and then to select the client group or filter of clients that should be 
removed.  Click the Finish button to perform the operation. 

 
 

Create a Group of Call Records 
 
Call Records are a great marketing tool to track who needs to be called for upcoming 
sessions and appointments.  You also might want to make a call record for a client 
that is overdue on a payment or still has proofs outstanding.  To create a call record, 
follow the steps below. 
 

1. Click Tools ⇒  Create a Group of Call Records. 
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2. A Create Call Records wizard will appear to walk you through the process. 
 

3. From the drop down box choose the filter for the group of clients you want to 
make the call records for.  This works great for special events.  When used 
with a filter using Groups or Calling Plans, you can set up call records to 
many clients without having to remember, or search for, who might be 
interested in the next special event.  Click Next. 

 
4. Enter in all of the necessary call information.  Click Next. 

 
5. Enter your notes about the call record.  Click Next. 

 
6. A message will come up indicating that you are about to create call records 

for all clients in the current filter.  Click Finish. 
 

 
 

Delete a Group of Clients 
 

Delete a Group of Clients is just that, the ability to permanently delete a group of 
client records.  This grouping will be based on an existing client group or filter that 
you created with the Filter Builder feature.  To delete a group of records, follow the 
steps below. 
 

1. Click Tools ⇒  Delete a Group of Clients. 
 

2. From the drop down box in the Group Delete dialog box, choose the client 
group or filter upon which you want to base the group delete. 

 
3. Click the Delete button. 

 
4. You will receive a message box indicating that you are about to permanently 

delete a group of records.  It will also ask if you are sure you want to 
continue. 

 
5. Click the Yes button.  If you don’t want to continue, click the No button. 

 

 Here’s a Flash for You! 
 
If a client has existing session or invoice records, the record will be skipped and 
not deleted. 
 

 
 

End of Day Posting Procedure 
 
Posting is a process that locks financial transactions, like invoices and payments, into 
the system so that they cannot be changed.  A posting does not technically have to 
occur at the end of the day, but should occur whenever you make a deposit (but not 
more than once a day.)   When you post, the following items occur.  First, summary 
and detail reports are printed to verify your transactions.  Second, the transactions 
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are locked so they cannot be modified.  Third, if you are using an external accounting 
software, such as QuickBooks, a summary of the financial transactions are exported 
to the accounting software.  Fourth, sales tax/VAT is now calculated for the Sales 
Tax/VAT reports.  

 

 Bugged About Something?? 
 
Should I be concerned about Posting? 
 
Posting is not required feature.  However, if you answer ‘yes’ to any of these 
questions, then you should post and post regularly.  Do you want to export your 
financial transactions to an external accounting software like QuickBooks?  Do 
you want to print a daily cash receipts report that matches your deposits?  Do 
you want to lock financial transactions so that they can not be modified after a 
certain date?  Do you want to generate a Sales Tax/VAT report?  If you 
answered yes to any of these questions, then you should post.  If you answered 
no to all of these questions, than you can skip the posting procedure.  
 

 

 
 
1. Click Tools ⇒  End of Day Posting Procedure 
 
2. Step 1 – Enter Today’s Receipts.  Enter the amount of bank deposit and 

various credit card deposits into the appropriate fields. 
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3. Step 2 – Print Posting Reports.  Check the posting report you want to see and 
click print.  Now is the time to verify the accuracy of your financial transactions.  If 
the deposit totals that you entered in step one do not match the transactions 
entered in, Portrait One Manager will post the difference to a Cash Over/Short 
account.  If you discover that you entered an incorrect deposit amount in step 
one or a financial transaction, such as an invoice or payment, needs to be 
corrected, now is the time to do so before continuing. 

 
4. Step 3 – Post All Records.  Click the Post button to actually perform the 

posting.  This step will flag all invoice and payment records as posted.  Once 
posted, they cannot be modified. 

 
5. Click Close to close the End of Day Posting window. 

 
 

 Here’s a Flash for You! 
 
Portrait One Manager gives you three different accounting methods to determine 
how to invoices are posted.  See the Company Preferences ⇒  Accounting tab to 
change this option.  Payments are always posted as soon as you enter them. 
  
Cash Basis 1 - Invoices will be posted as revenue when the balance due is 

equal to zero. 
Cash Basis 2 - Invoices will be posted as revenue when the balance due is 

equal to zero AND the product delivery date has been completed on the 
invoice. 

Accrual - Invoices are posted and counted as revenue immediately when they 
are generated. 

 
 
 

 Bugged About Something?? 
 
Can I reprint a posting report or can I re-export data to my accounting 

software? 
 
Of course you can.  To do so click Report ⇒  Reprint Posting Reports.  Select the 

appropriate Action, Reports, and Posting Date.  Then click Print. 
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Daily Sales Report 
 

The Daily Sales Report prints a summary of all item sales per day for any one week 
time period. 

 
 

Sales Tax Report 
 

The Sales Tax Report provides sales tax information for each sales tax rate 
established in each sales tax location.  Either a summary or a detailed version can be 
printed. 

 
 

Accounts Receivable Aging Report 
 
The Accounts Receivable Aging Report is available in either a summary or detailed 
format. 
 
The Aging Summary Report lists the total amounts not yet due, total amounts past 
due, and total open balance for each client. 
 
The Aging Detail Report lists the invoice number, date, bill-to name, invoice total, 
amount paid, open balance, and due date for all invoices with a past due amount.  
This report is grouped by client. 

 
 

Reprint Posting Reports 
 

The Reprint Posting Report feature gives you the ability to reprint a posting report for 
a specific day.  You can also re-export posting data to your accounting software for a 
specific day. 

 
 

Print Group of Invoices 
 

The Print Group of Invoices feature is great if you need to send a reminder to clients 
that have a past due balance.  You can select a group of invoices based on a 
predefined filter, an invoice date range, or based on the amount of days an invoice is 
past due.  Once the Print button is clicked, you will be prompted with a confirmation 
showing how many invoices will be printed.  Click OK to continue with the printing. 

 
 

Client Lists and Labels 
 

Client Lists – The Client List prints a client name, number, address, and home 
phone for each client in a client group or filter. 
 
Mailing Labels  – Mailing Labels print the client name and address for each client in 
a client group or filter.  Labels are printed in a standard Avery 5160 format. 
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Account Labels  – Account Labels print the client name, number, address, and 
home phone for each client in a client group or filter.  Labels are printed in a standard 
Avery 5160 format. 

 
 

Session Lists and Labels 
 

Session Lists – The Session List prints a client name, session number, start time, 
end time, session type and status for each session in a session promotion or filter. 
 
Session Labels  – Session Labels print the client name, client number, session date, 
time, type, photographer, and session number for each session in a session 
promotion or filter.  Labels are printed in a standard Avery 5160 format. 

 
 

Invoice Lists 
 

The Invoice List provides the invoice number, invoice date, due date, bill to name, 
sub total, discount, shipping, tax, invoice total, amounts paid, and open balance of all 
invoices that exist in a particular filter.  Totals are also provided at the end of the 
report. 

 
 

Payment Lists 
 

The Payment List provides the payment date, invoice number, invoice date, session 
number, client number, bill to name, credit card or check number, payment amount, 
and current open balance of all payments that exist in a particular filter or within a 
particular payment date range.  Payments can also be grouped by payment method.  
Totals are also provided at the end of the report. 

 
 

Price Lists 
 

The Price List report prints a list of all the items in a chosen price list.  The report 
details the item identifier, description, and price for each item.  Items are grouped by 
the item group the item belongs to.  

 
 

Order Status Reports 
 

The Order Status Report prints a list of all the Proof or Production Orders that match 
a certain criteria.  Criteria can be based on all statuses, a single status, or a 
predefined filter.  In addition, the report can also be limited to a certain due date 
and/or a certain vendor.  Once the criteria has been selected, you can select how the 
orders should be sorted, by order number, due date, or client name.  The report 
includes the order number, due date, status, vendor, and client name for each order.  
In addition, the report also tells the total value, taken from the invoice totals, of the 
orders in each status.  This information can be very helpful in determining cash flow 
projections.  For example, you may have $2,592 worth of orders sitting on your shelf 
waiting for clients to come in and pick up. 
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Pictorial Directory 
 

If you have access to digital images for your clients, the Pictorial Directory can be a 
great product that you can provide to your clients.  It can be printed, placed on a CD, 
or placed on a web site.  What is a Pictorial Directory?  It is a document that you can 
generate that includes an image of each client along with customized text that 
appears below each image.  Here’s how it works.  For each client that you want 
included, you must select a primary image.  This can be done by clicking File ⇒  
Acquire Client Image on the client information screen or by right clicking on an image 
on the Session ⇒  Images tab and clicking Make This Image The Main Client Image.  
To confirm that a client has an image selected, click File ⇒  Preview Client Image on 
the Client Information Screen.  Next, click Reports ⇒  Pictorial Directory.  Select the 
criteria for the report and the display options.  Most importantly, click the Edit Image 
Captions button to determine what text you want to appear under each image.  The 
document can then be printed or exported as an Adobe PDF or HTML document. 

 

 Pathways to Success  
 
Be creative with how you use Pictorial Directories.  Sell it as an actual product to 
generate additional revenue or give it to your client as an incentive or perk.  Here 
are some examples of how you can use this exciting product: 
 
•  Religious organizations like churches 
•  Non-profit organizations or clubs 
•  Sports teams like a soccer team 
•  Dance teams 
•  Corporate directory 
 

 
 

High School Senior List 
 

The High School Senior List is a simple report that prints a list of all the High Schools 
that have been entered in the High School Maintenance List.  The report includes the 
high school name, address, phone, yearbook deadline, and yearbook requirements. 

 
 

Senior Session List 
 

The Senior Session List prints a status report of all the sessions for one or more high 
schools.  The report is based on a session date range.  The report includes session 
number, date, client name, home phone, and the session status. 

 
 

Profit Analysis Report 
 

The Profit Analysis Report is a powerful tool to help evaluate the performance of your 
studio by determining how profitable your sessions are. First, select what type of 
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report you want to generate, General, Client Group, or Session Promotion.  The 
report type will determine what filter and grouping options are available to you.  Next 
select a filter or a date range to determine which invoices should be included in the 
report.  Then select how you want your report to be grouped.  Do you want to view 
the profitability of your different session types, photographers, lead sources, 
promotions, or a certain client group?  Then print or preview the report.  The report 
will then show the number of sessions in each grouping, the total revenue and total 
profit for each group, the average revenue and profit for each session, and a gross 
profit margin for each group.  How does the report calculate total revenue?  The 
report totals all the subtotals for each invoice that belongs to all the sessions in the 
group.  How does the report calculate total profit?  The report calculates profit by 
taking the total revenue minus the total cost.  The cost of each session can be 
determined by you in the Company Preferences ⇒  Reports 2 tab (see Application 
Maintenance section of this manual.) 

 
 

Sales Analysis Report 
 

The Sales Analysis Report is another powerful tool to help evaluate the performance 
of your studio by viewing sales figures broken down in a variety of formats.  First, 
select what type of report you want to generate, General, Client Group, or Session 
Promotion.  The report type will determine what filter and grouping options are 
available to you.  Next select a filter or a date range to determine which invoices 
should be included in the first column of the report.  Optionally, you can select a 
second column of data, which is useful to compare two months, quarters, years, etc.  
Then select how you want your report to be grouped.  Do you want to view sales 
figures for each photographer, sales person, lead source, promotion, or client group?  
Then print or preview the report.  For each group, the report will break down the sales 
figures by the product lines that you have assigned to each item.  The Quantity Sold 
columns simply totals all the quantities for the items that appear in this product line.  
This number is helpful to compare the number of products sold in a product line 
versus the total revenue generated for this product line.  The Total Sales columns 
total all the sales for this product line and grouping on the report.  The Percentage 
columns are helpful to compare how each product line and report grouping compare 
to the overall revenue of the studio. 

 
 

Session Trends Report 
 

The Session Trends Report totals the number of sessions for each session type on a 
monthly basis.  The report lists current year, previous year and percent change 
figures. 

 
 

Custom Reports 
 

Do you need a report that Portrait One Manager does not provide?  No problem.  
Because Portrait One Manager stores its data in a Microsoft Access database, you 
can create your own custom reports using Microsoft Office products, like Word, 
Excel, and Access, or third-party report generator like Crystal Reports by Seagate.  
The most powerful tool to create custom reports is Microsoft Access, which can be 
purchased stand-alone or as a part of the Microsoft Office Professional Version.  The 
version must be 2000 or greater.  Portrait One Manager stores its data in a file called 
SamDB.mdb.  You must attach your application, like Word, Excel, or Access, to this 
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file to get access to your data.   For more information on creating your custom 
reports, see Word, Excel, Access, or other third party documentation. 
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Features of the Database Utility 
 

The Portrait One Manager Database Utility is used maintain the Portrait One Manager 
data files.  To use the Database Utility, click the Start Menu ⇒  Programs ⇒  Portrait One 
Manager ⇒  Database Utility. 
 

 
 

2. Create New Data Files.  Use this feature only if you want to create a new blank 
set of data files.  After clicking this button, you will be prompted to determine the 
location of the new data files.  You must select an empty folder that does not 
already contain a set of data files.   

 
3. Move Data Files.  Use this feature if you want to move the data files to a new 

location.  A common use of this feature is to move from a Single User Installation 
to a Multiple User Installation by moving the data files to a new location on your 
file server.  After clicking this button, you will be prompted to select the new 
location for the data files.  You must select an empty folder that does not already 
contain a set of data files.   

 
4. Attach to Different Data Files.  Use this feature if you need to connect to a 

different set of data files than you are already connected to.  After clicking this 
button, you will be prompted to choose the data files that you wish to connect to. 

 
5. Compact and Repair Data Files.  Two reasons exist to use this feature.  First, 

to keep your database running optimally, it is recommended that you compact 
the data files regularly.  Second, if you ever receive an error similar to 
‘Unrecognized Database Format’ when you launch Portrait One Manager, you 
need to repair your data files.  It is recommended that you backup your data files 
prior to running a Compact and Repair.   

 

 Here’s a Flash for You! 
 
It is highly recommended that you Compact your data files periodically, at least 
weekly.  But why?  Portrait One Manager stores its data in Microsoft Access Data 
Tables.  Access builds its own internal temporary files.  Running a compact 
rebuilds the data files and removes any temporary files.  Not only will the data 
files be reduced in size, but performance can increase, and data corruption can 
be prevented. 
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6. Backup Data Files.  Use this feature to create a backup copy of your data files.  
After clicking this button, you’ll be prompted to choose a location for your backup.  
If you choose the default Backup folder, then you need to be responsible to copy 
these files onto a separate media, like a zip disk, CD, or backup tape.   

 

 

    ATTENTION!   
 
Make sure that you backup your data files DAILY, by either using the Portrait 
One Manager backup utility or by using your own backup software!  If your data 
files become corrupted beyond repair or if your hard drive crashes, you will lose 
all of your data, unless you have a current backup.    
 

   
 
7. Restore Data Files.  Use this feature if you ever need to restore a backup copy 

of data files.  Remember, this feature will replace your current data files with a 
previous copy.  Only proceed if you no longer need the data files you are 
currently attached to.  After clicking this option, select the folder that contains the 
backup you want to restore.  Then select the backup that you want to restore and 
click the Restore button.   

 
8. FTP Data Files to Tech Support.  Use this feature only if instructed to by a 

technical support specialist.  Doing so will zip your data files and transfer them 
over the Internet to the Portrait One Manager Technical Support Department. 
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Getting Technical Support 
 

Portrait One Manager is continually being enhanced and updated.  All updates and 
upgrades will be posted to our web site (www.StudioPlusSoftware.com) regularly.  
We recommend that you check it often and download the newest updates. 
 
From online services to expert telephone support, we at Portrait One Manager 
Software offer several avenues of technical assistance so that you can be assured of 
having your questions answered quickly and professionally.  You can reach us in any 
of the following ways: 
 
Email 

Support@StudioPlusSoftware.com (or click Email Technical Support from the 
Help Menu) 
 

Web 
www.StudioPlusSoftware.com  
 

Telephone 
(763) 689-1131, Option 2 (Monday-Friday 8:30 AM - 5:00 PM Central Time USA) 
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End User License Agreement 
 

IMPORTANT - THIS AGREEMENT CONTAINS AND EXPLAINS IMPORTANT LEGAL 
RIGHTS AND LIMITATIONS. PLEASE READ IT CAREFULLY, AND PRIOR TO 
INSTALLATION OR ANY USE OF THE SOFTWARE PRODUCT   
 
 This End-User Software License Agreement (the "Agreement") is a legal 
agreement between you (either an individual or a single entity) and Portrait One 
Manager Software, LLC ("StudioPlus") for the Portrait One Manager software 
product identified above, which includes computer software and may include 
associated media, printed materials, and "online" or electronic documentation, as 
well as any enhancements, modifications or upgrades that may be offered to 
licensed end users as specified herein  (collectively, the "SOFTWARE PRODUCT").  
By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to 
be bound by the terms of this Agreement.  If you do not agree to the terms of this 
Agreement, do not install or use the SOFTWARE PRODUCT; you may, however, 
return it to the source for a full refund. 
 
SOFTWARE PRODUCT LICENSE 
 
The SOFTWARE PRODUCT is protected by copyrights laws and international copyright 
treaties, as well as other intellectual property laws and treaties.  The SOFTWARE 
PRODUCT is licensed, not sold.  The license granted under this Agreement is perpetual, 
nonexclusive and nontransferable, except as provided in Section 3. 
 
1. GRANT OF LICENSE.   
 
 Evaluation Software.  Unless and until the SOFTWARE PRODUCT has been 
registered with and activated by Portrait One Manager, you are using the SOFTWARE 
PRODUCT under a single computer, nontransferable evaluation license.  You may use 
the SOFTWARE PRODUCT free of charge for a single, concurrent 30 day evaluation 
period. If you wish to license the SOFTWARE PRODUCT for use after the 30 day 
evaluation period, you must contact Portrait One Manager for registration and activation 
instructions and requirements before the end of the 30 day evaluation period. 
 
Following full payment of the applicable license fees and registration and activation with 
Portrait One Manager, this Agreement grants you either of the following rights: 
 
 Single User License.  You may install and use one copy of the SOFTWARE 
PRODUCT, or any prior version for the same operating system, on a single computer. You 
must acquire and dedicate a separate single user license for each separate computer on 
which the SOFTWARE PRODUCT is installed, and the SOFTWARE PRODUCT may not 
be shared or used concurrently on different computers, and cannot be accessible via 
network, remote access or similar means. 
 
 Network License.  You may install the SOFTWARE PRODUCT, or any prior 
version for the same operating system, on multiple computers connected to your internal 
network.  You may also store or install a copy of the SOFTWARE PRODUCT on a storage 
device, such as a network server, used only to install or run the SOFTWARE PRODUCT 
on your other computers over an internal network.  You are not limited to the number of 
computers to which the software may be loaded upon, however, you are limited to the 
specified number of concurrent licensed users that may be running the SOFTWARE 
PRODUCT at one time.  Network license increases may be acquired by obtaining a new 
key card from Portrait One Manager. 
 
2. OTHER VERSIONS OF SOFTWARE. 
 Beta Software.  If the SOFTWARE PRODUCT is labeled "Beta" (on the “About” 
screen in the “Help” menu), then, notwithstanding other sections of the Agreement, you 
shall have 30 days to use the SOFTWARE PRODUCT and to provide feedback to Portrait 
One Manager regarding the use of the SOFTWARE PRODUCT.  After 30 days, the Beta 
license shall terminate unless you contact Portrait One Manager before the end of the 30 
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day period and Portrait One Manager agrees to extend the term of the Beta license, or to 
offer you a different license.  There is no cost to you for using the SOFTWARE PRODUCT 
under a Beta license. 
 
 Not for Resale Software.  If the SOFTWARE PRODUCT is labeled "Not for 
Resale" or "NFR", then, notwithstanding other sections of the Agreement, you may not 
resell, or otherwise transfer for value, the SOFTWARE PRODUCT. 
 
3. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS. 
 
 Limitations on Use; Operating Requirements. In exchange for the rights to 
licensed use of the SOFTWARE PRODUCT, you agree not to copy, modify, reverse 
engineer, decompile, or disassemble the SOFTWARE PRODUCT. The SOFTWARE 
PRODUCT is specifically designed for operation on certain operating systems and for use 
with certain minimum hardware specifications, all of which are available from Studio Plus, 
or at www.StudioPlusSoftware.com.  
  
 Separation of Components.  The SOFTWARE PRODUCT is licensed as a 
single product.  Its component parts may not be separated for use on more than one 
computer. 
 
 Rental.  Except as may be pre-authorized in writing by Studio Plus, you may not 
rent, lease, or lend the SOFTWARE PRODUCT, or use it to provide any service bureau or 
similar services to any third parties. 
 
 Optional Support Services.  Upon your request, StudioPlus may provide you 
with certain optional telephone support, maintenance, or error correction services related 
to the SOFTWARE PRODUCT ("Support Services").  Support Services are provided 
under and governed by the then-current StudioPlus policies and programs, which are 
available at www.StudioPlusSoftware.com, and are subject at all times to prepayment of 
the applicable Support Services fees.  Any supplemental software code provided to you as 
part of the Support Services shall be considered part of the SOFTWARE PRODUCT and 
subject to the terms and conditions of this Agreement.  With respect to technical 
information you provide to StudioPlus as part of the Support Services, StudioPlus may use 
such information for its business purposes, including for product support and 
development.  StudioPlus will not utilize such technical information in a form that 
personally identifies you. 
 
 Software Transfer.  You may permanently transfer all of your rights under this 
Agreement to a successor to your entire business, and, provided that:  (a) you retain no 
copies, excerpts, documentation or related materials; (b) you transfer all of the 
SOFTWARE PRODUCT (including all component parts, the media and printed materials, 
any upgrades, this Agreement, and, if applicable, the Certificate of Authenticity); (c) the 
recipient agrees to the terms of this Agreement in writing, and provides a signed copy of 
such agreement to StudioPlus on its then-current transfer forms prior to such transfer; and 
(d) Studio Plus’s then-current transfer fee (which will in no event exceed 25% of the then-
current license fee .  If the SOFTWARE PRODUCT is an upgrade, any transfer must 
include all prior versions of the SOFTWARE PRODUCT. 
 
 Applicable Laws. Your possession and use of the SOFTWARE PRODUCT is 
subject at all times to your compliance with all security, export and other applicable laws of 
the United States of America and any applicable foreign countries. 
 
 Termination.  This Agreement will remain in effect until terminated. The parties 
may terminate this Agreement at any time by mutual written agreement. Without prejudice 
to any other rights, StudioPlus may terminate this Agreement if you fail to comply with the 
terms and conditions of this Agreement.  Upon any termination, you must destroy or return 
to Studio Plus all copies of the SOFTWARE PRODUCT and all of its component parts. 
 
4. UPGRADES. 
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If the SOFTWARE PRODUCT is enhanced or otherwise modified, it will be labeled as an 
upgrade In order to use any upgraded version of the SOFTWARE PRODUCT, you must 
be properly licensed by StudioPlus, and must have paid the applicable upgrade fees, or 
have been granted such use as part of a then-current support agreement.  A SOFTWARE 
PRODUCT labeled as an upgrade replaces and/or supplements the product that formed 
the basis for your eligibility for the upgrade.  You may use the resulting upgraded product 
only in accordance with the terms of this Agreement.  If the SOFTWARE PRODUCT is an 
upgrade of a component of a package of software programs that you licensed as a single 
product, the SOFTWARE PRODUCT may be used and transferred only as part of that 
single package and may not be separated for use on more than one computer. 
 
5. COPYRIGHT.   
 
All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to 
any images, photographs, animations, video, audio, music, text, and "applets" 
incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and 
any copies of the SOFTWARE PRODUCT are owned by StudioPlus or its suppliers.  The 
SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions.  
Therefore, you must treat the SOFTWARE PRODUCT like any other copyrighted material 
except that you may install the SOFTWARE PRODUCT on a single computer provided 
you keep the original solely for backup for archival purposes.  You may not copy the 
printed materials accompanying the SOFTWARE PRODUCT. 
 
6. DUAL-MEDIA SOFTWARE.   
 
You may receive the SOFTWARE PRODUCT in more than one medium.  Regardless of 
the type or size of medium you receive, you may use only one medium that is appropriate 
for your single computer.  You may not use or install the other medium on another 
computer.  You may not loan, rent, lease, or otherwise transfer the other medium to 
another user, except as part of the permanent transfer (as provided above) of the 
SOFTWARE PRODUCT. 
 
7. LIMITED WARRANTY; LIMITATION OF LIABILITY AND REMEDIES.   
 
ALL OF STUDIO PLUS’S WARRANTIES AND ITS ENTIRE LIABILITY WITH REPSECT 
TO THE SOFTWARE PRODUCT IS AS FOLLOWS; 
  
StudioPlus warrants only that it owns the SOFTWARE PRODUCT, and that the 
SOFTWARE PRODUCT will perform substantially in accordance with the accompanying 
written materials for a period of ninety (90) days from the date of your initial receipt of the 
SOFTWARE PRODUCT in any form or version.  
 
StudioPlus and its suppliers’ entire liability and your exclusive remedy for breach of the 
aforementioned limited warranty shall be, at StudioPlus’ option, either (a) return of the 
license fees paid, if any, or (b) repair or replacement of the SOFTWARE PRODUCT that 
does not meet StudioPlus’ Limited Warranty and which is returned to StudioPlus with a 
copy of your receipt.  This Limited Warranty is void if failure of the SOFTWARE 
PRODUCT has resulted from any accident, abuse, third party modification or other 
misapplication.  Any replacement SOFTWARE PRODUCT will be warranted for the 
remainder of the original warranty period or thirty (30) days, whichever is longer.  Outside 
the United States, neither these remedies nor any product support services offered by 
StudioPlus are available without proof of purchase from an authorized international 
source. 
 
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW AND EXCET AS SET 
FORTH ABOVE, STUDIOPLUS AND ITS SUPPLIERS DISCLAIM ALL OTHER 
WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS 
FOR A PARTICULAR PURPOSE, WITH REGARD TO THE SOFTWARE PRODUCT. 
YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE/JURISDICTION TO 
STATE/JURISDICTION.  Some states and jurisdictions do not allow limitations on 
duration of an implied warranty, so the above limitation may not apply to you.  To the 
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extent allowed by applicable law, implied warranties on the SOFTWARE PRODUCT, if 
any, are limited to ninety (90) days. 
 
IN EXCHANGE FOR THE LICENSE AND RIGHTS GRANTED HEREUNDER, YOU 
FURTHER AGREE THAT,TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE 
LAW, STUDIOPLUS OR ITS SUPPLIERS SHALL IN NO EVENT BE LIABLE FOR ANY 
SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES 
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF 
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF 
OR INABILITY TO USE THE SOFTWARE PRODUCT OR THE PROVISION OF OR 
FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF STUDIOPLUS HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN ANY CASE, 
STUDIOPLUS’S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT 
SHALL BE LIMITED TO THE GREATER OF THE AMOUNT ACTUALLY PAID BY YOU 
FOR THE SOFTWARE PRODUCT OR U.S. $100.00.  
 
HOWEVER, IF YOU HAVE ENTERED INTO A STUDIOPLUS SUPPORT SERVICES 
AGREEMENT, STUDIOPLUS’S ENTIRE LIABILITY REGARDING SUPPORT 
SERVICES SHALL BE GOVERNED BY THE TERMS OF THAT AGREEMENT.  
BECAUSE SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF LIABILITY, THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 
 
 
You acknowledge that the SOFTWARE PRODUCT would not have been made available, 
or would have been made available at significantly higher license fees in absence of these 
warranty limitations and damage exclusions.     
 
 
8. GOVERNING LAW: JURISDICTION AND VENUE 
 
This Agreement is being offered under, and will be governed by the internal laws of the 
State of Minnesota, without regard for conflicts of law principles.  By entering into this 
Agreement, you irrevocably consent to the jurisdiction and venue of the applicable courts 
located in Ramsey County, Minnesota, and agree that any disputes or claims arising 
hereunder will be brought in such courts.8. 
 
 
9. GENERAL 
 
This Agreement (and any Support Services agreement then in force) constitutes the entire 
agreement and understanding between the parties regarding the subject matter, and 
supersedes all prior oral or written agreements or understandings. This Agreement may 
only be waived or otherwise modified by a written addendum signed by the authorized 
representatives of the parties.    
 
In the event a court of competent jurisdiction determines that any portion of this 
Agreement is invalid or unenforceable, such a finding shall not invalidate the remainder of 
this Agreement, which will remain in full force and effect.  
 
You agree that any breach or violation of this Agreement involving the unauthorized use or 
disclosure of confidential or proprietary information or materials is likely to result in 
irreparable harm to StudioPlus, and that in such event, that StudioPlus will be entitled to 
obtain a court order enjoining you from such conduct. 
 
In the event any lawsuit or other enforcement action is undertaken to enforce StudioPlus’ 
rights hereunder, you agree to reimburse Studio Plus for its reasonable attorney’s fees 
and other costs incurred in enforcing such rights. 
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Quick Reference Guide 
 

How to enter a new client?   
From any browse screen, click File�New Client or press Ctrl+ N. 
 
How to find an existing client?    
Change to the Client Browse Screen and enter a selection criteria at the top right of the screen.  
Double click on the desired client.   
 
How to enter a new session?   
From the Calendar Browse Screen, double click on the desired date and time for the 
photographer of the session to launch the Schedule Wizard.  
 
How to find an existing session?    
If you know the date and time of the session, switch to the calendar browse screen, find the date 
and time for the photographer, and double click on the session box on the calendar.  If you know 
the session number, switch to the Session Browse Screen, enter the session number in the 
selection criteria field at the top of the screen, and double click on the desired session.  If you 
know the client’s name, follow the instructions above to find the desired client.  Next, click on the 
Session detail tab to find the desired session and double click.   
 
How to enter an invoice?    
Find the appropriate session that the invoice is related to by using the steps described above. 
From the Session Information Screen, click on the New Invoice button on the tool bar.   
 
How to find an existing invoice?  
If you know the invoice number. switch to the Invoice Browse Screen.  Enter the invoice number 
in the selection criteria field at the top of the screen and double click on the desired invoice.  If 
you know the client name, session number or date, follow the steps above to find the existing 
client or session screen. From the Client or Session Information screen, click on the Invoices 
detail tab and then double click on the desired invoice.  
 
How to enter a payment?   
Use the steps above to find the invoice for which the payment is being received. From the Invoice 
Information Screen, click on the New Payment button on the tool bar.   
 
How to view phone calls that are due?   
Switch to the Phone Calls Browse screen and use the select user field at the top of the screen to 
choose the user or users for which phone calls should be displayed.  Clicking on the due date 
column header in the grid will sort the phone calls in the order of their due date. 
 
How to view production status?   
Switch to the Production Browse Screen.  This screen may be displayed in a number of ways by 
using the criteria selection in the upper right corner. 
 
How to enter a proof order?   
Given the steps above, find the session to which the proof order is related.  From the action 
menu, select ‘Create new proof order’. 
 
How to enter a production order? 
Given the steps above, find the invoice that relates to the production order you wish to create.  
From the action menu, select create new production order. 

 
 


